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Preface

This document describes how to install and use the Event Replicator Target Adapter Administration
to configure your Event Replicator Target Adapter installation.

Notes:

1. The Event Replicator Target Adapter must be stopped and restarted every time an Event
Replicator Target Adapter definition is saved or deleted using the Administration tool. For this
reason, we recommend that you shut down the Event Replicator Target Adapter prior to making
changes to the definitions and restart the Event Replicator Target Adapter when all definition
changes are complete. For information about stopping and starting the Event Replicator Target
Adapter, read Shutting Down the Event Replicator Target Adapter and Starting the Event Replicator
Target Adapter, in the Event Replicator Target Adapter User Guide.

2. The Event Replicator Target Adapter Administration Tool and the Data Mapping Tool are not
supported in HP-UX or zLinux environments because the Eclipse RCP port is not available in
those environments. You will need to have a Windows, AIX, Solaris, or Linux installation of
the Administration Tool and Mapping Tool to use them. The Administration Tool can remotely
manage Event Replicator Target Adapter installations on those platforms where the Eclipse
RCP is not supported.

This document covers the following topics:

Provides an overview of Event Replicator Target Adapter
Administration.

Event Replicator Target Adapter
Administration Overview

Describes the updates to Event Replicator Target Adapter
Administration since the last release.

Release Notes

Describes the prerequisites, system requirements, and steps to
install and uninstall Event Replicator Target Adapter
Administration.

Installing Event Replicator Target Adapter
Administration

Describes the Administration tool interface as well as how to
start and stop it.

About the Event Replicator Target Adapter
Administration Tool

Describes the activation of your Event Replicator Target Adapter
Administration license.

Activating Your Event Replicator Target
Adapter License

Describes the Event Replicator Target Adapter engine
configuration parameters and how to maintain them.

Maintaining the Event Replicator Target
Adapter Engine Configuration

Describes the Event Replicator Target Adapter persistent store
(WebDAV) configuration parameters and how to maintain
them.

Maintaining the Event Replicator Target
Adapter Persistent Store (WebDAV)
Configuration

Describes how to configure the Event Replicator Target Adapter
target definitions for your target RDBMS databases and web
services.

Configuring Target Definitions for Event
Replicator Target Adapter
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Describes how to specify options for Event Replicator Target
Adapter processing with target RDBMS databases.

Specifying Target Database Processing
Option Definitions

Describes how Event Replicator Target Adapter filter processing
works and how to maintain filter definitions for filter processing.

Specifying Filter Definitions

Describes how to configure the Event Replicator Target Adapter
source definitions for the webMethods EntireX or WebSphere
MQ messaging systems you are using.

Configuring Source Definitions for Event
Replicator Target Adapter

Explains how to verify the webMethods EntireX or WebSphere
MQ source definition connections you have configured.

Verifying Your Source Definition
Connections

Describes how you can use the Administration tool to review
and dynamically alter the configuration, source, target, filter,
and target database processing definitions you have specified.

Reviewing and Dynamically Altering
Definitions

Describes how to review Event Replicator Target Adapter log
files from the Administration tool.

Reviewing Log Files

Describes how to review Event Replicator Target Adapter
processing statistics from the Administration tool.

ReviewingEventReplicator TargetAdapter
Statistics

Event Replicator Target Adapter Administrationvi
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1 Event Replicator Target Adapter Administration Overview

Use the Event Replicator Target Adapter Administration tool to configure your Event Replicator
Target Adapter installations. This can be multiple installations for different versions and/or different
machines. For each target adapter configured for administration, you can use it to:

■ Set up Event Replicator Target Adapter processing preferences. These preferences identify,
among other things, the location of the context.xml file used to store the Event Replicator Target
Adapter definitions, the locations of the Event Replicator Target Adapter startup and shutdown
commands, and the location of the Event Replicator Target Adapter log files.

Caution: We do not recommend that you alter Event Replicator Target Adapter definitions
in the context.xml file using a text editor or any other editor other than the Event Replic-
ator Target Adapter Administration tool. If you do, errors may result.

■ Configure the target definitions for your installation. Target definitions define the RDBMS data
base or web service various types of targets to which the Event Replicator Target Adapter should
direct the replicated data. For more information, read Configuring Target Definitions for Event
Replicator Target Adapter, elsewhere in this guide.

■ Set up any target processing option definitions needed for Event Replicator Target Adapter
processing. Target database processing option definitions specify options regarding how the
Event Replicator Target Adapter processes the data submitted to the target. For more information,
read Specifying Target Database Processing Options, elsewhere in this guide

■ Configure the source definitions for your installation. Source definitions define the messaging
system to be used (webMethods EntireX or WebSphere MQ) and associated target definition to
which the Event Replicator Target Adapter should direct the replicated data acquired from the
source definition. For more information, read Configuring Source Definitions for Event Replic-
ator Target Adapter, elsewhere in this guide.

■ Configure any filter definitions for Event Replicator Target Adapter processing. For more in-
formation, read Specifying Filter Definitions, elsewhere in this guide
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This chapter provides release notes for the Event Replicator Target Adapter Administration 3.2
release. It is organized as follows:

Enhancements

Event Replicator Target Adapter Administration Version 3.2 supports administration of Event
Replicator Target Adapter versions 3.0, 3.1 and 3.2. As of this release, a single running instance of
Event Replicator Target Adapter Administration has the ability to manage multiple versions and
instances, both local and remote, in a single administration console.

Changes in this version include:

■ introduction of a new Target Adapter Option, Include Commit Information (applicable to JMS
target definitions only).

Note: This option is introduced as of Fix 3 to Event Replicator Target Adapter Version
3.2 SP0. Prior to the release of this fix, the behavior was to include commit information
in the replicated information. In order to turn off this behavior, you must re-save the JMS
Target configuration with the Include Commit Information box un-checked to record
the desired configuration in the active context.xml file for the Target Adapter.

End of Maintenance

For information on how long a product is supported by Software AG, access Software AG's Em-
power web site at https://empower.softwareag.com.

Log into Empower. Once you have logged in, you can expand Products in the left menu of the
web page and select Product Version Availability to access the Product Version Availability ap-
plication. This application allows you to review support information for specific products and
releases.

Documentation and Other Online Information

The following online resources are available for you to obtain up-to-date information about your
Software AG products:

■ Software AG Documentation Website
■ Software AG TECHcommunity

Event Replicator Target Adapter Administration4
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■ Software AG Empower Product Support Website

Software AG Documentation Website

You can find documentation for all Software AG products on the Software AG Documentation
website at http://documentation.softwareag.com. This site requires Empower credentials. If you
do not have an Empower user ID and password yet, you will find instructions for registering on
this site (free for customers with maintenance contracts) or you can also use the TECHcommunity
website to access the latest documentation.

Software AG TECHcommunity

You can find documentation and other technical information on the Software AG TECHcommunity
website at http://techcommunity.softwareag.com. You can:

■ Access product documentation, if you have TECHcommunity credentials. If you do not, you
will need to register and specify "Documentation" as an area of interest. If you already have
TECHcommunity credentials, you can adjust your areas of interest on the TECHcommunity
website by editing your TECHcommunity profile. To access documentation in the TECHcom-
munity once you are logged in, select Documentation from the Communities menu.

■ Access articles, demos, and tutorials.
■ Use the online discussion forums, moderated by Software AG professionals, to ask questions,

discuss best practices, and learn how other customers are using Software AG technology.
■ Link to external websites that discuss open standards and web technology.

Software AG Empower Product Support Website

You can find product information on the Software AG Empower Product Support website at ht-
tps://empower.softwareag.com. This site requires Empower credentials. If you do not have an
Empower user ID and password yet, you will find instructions for registering on this site (free for
customers with maintenance contracts).

To submit feature/enhancement requests, get information about product availability, and download
products and certified samples, select Products & Documentation from the menu once you are
logged in.

To get information about fixes and to read early warnings, technical papers, and knowledge base
articles, select Knowledge Center from the menu once you are logged in.

5Event Replicator Target Adapter Administration
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This chapter describes the installation and uninstallation of Event Replicator Target Adapter Ad-
ministration. It covers the following topics:

Installation Overview

This product is installed using the Software AG Installer, which you can download from the
Software AG Empower website at https://empower.softwareag.com/.

The Software AG Installer offers typical development installations of Software AG products. When
you select a typical development installation, the installer automatically groups and selects the
Software AG products and components that make up that installation.

■ The Event Replicator Target Adapter Administration is part of the Event Replicator Target
Adapter product suite. It is installed separately from Event Replicator Target Adapter Data
Mapping Tool and the Event Replicator Target Adapter.

■ The Event Replicator Target Adapter Data Mapping Tool is part of the Event Replicator Target
Adapter product suite. It is installed separately from Event Replicator Target Adapter Admin-
istration and the Event Replicator Target Adapter.

■ The Event Replicator Target Adapter installation is part of the Event Replicator Target Adapter
product suite. It is installed separately from the Event Replicator Target Adapter Administration
and the Event Replicator Target Adapter Data Mapping Tool. Included in the installation of the
Event Replicator Target Adapter is the installation of an internal component called the Software
AG ERTA Administration Service. This service enables running the Event Replicator Target
Adapter as a system service and also allows communication with a remote administration console
(for example on platforms, such as HP and zLinux, where the Event Replicator Target Adapter
Administration tool cannot be installed)

The Infrastructure entry in the Software AG Installer includes the installation of Java. Java
should be installed so it can be accessed by all products in the Event Replicator Target Adapter
product suite and by the Software AG Installer.

You cannot ungroup installations that have been paired or grouped. However, you can select
multiple installation configurations for installation at the same time. To configure your installation
of these products and create effective production environments, work with your system adminis-
trators and Software AG Global Consulting Services.

Event Replicator Target Adapter Administration8
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System Requirements

This section describes the system requirements of Event Replicator Target Adapter Administration.

■ Supported Operating System Platforms
■ Supported Hardware
■ Supported Browsers
■ Supplied Third-Party Software
■ Space Requirements
■ Memory Requirements
■ Windows Requirements
■ Firewall Requirements

Note: We recommend that you read the install.txt file in the CD root directory for last-minute
information regarding the installation of the Event Replicator Target Adapter. We also re-
commend that you read the Event Replicator Target AdapterReadMe.txt files for last-minute
information regarding its operation. The Event Replicator Target Adapter readme.txt file
can be found in the CD root directory.

Supported Operating System Platforms

Software AG generally provides support for the operating system platform versions supported
by their respective manufacturers; when an operating system platform provider stops supporting
a version of an operating system, Software AG will stop supporting that version.

For information regarding Software AG product compatibility with IBM platforms and any IBM
requirements for Software AG products, please review the Product Compatibility for IBM Plat-
forms web page.

Before attempting to install this product, ensure that your host operating system is at the minimum
required level. For information on the operating system platform versions supported by Software
AG products, complete the following steps.

1. Access Software AG's Empower web site at https://empower.softwareag.com.

2. Log into Empower. Once you have logged in, you can expand Products & Documentation in
the left menu of the web page and select Product Version Availability to access the Product
Version Availability screen.

3. Use the fields on the top of this screen to filter its results for your Software AG product. When
you click the Search button, the supported Software AG products that meet the filter criteria
are listed in the table below the filter criteria.

This list provides, by supported operating system platform:
■ the Software AG general availability (GA) date of the Software AG product;
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■ the date the operating system platform is scheduled for retirement (OS Retirement);
■ the Software AG end-of-maintenance (EOM) date for the product; and
■ the Software AG end-of-sustained-support (EOSS) date for the product.

Note: Although it may be technically possible to run a new version of your Software AG
product on an older operating system, Software AG cannot continue to support operating
system versions that are no longer supported by the system’s provider. If you have questions
about support, or if you plan to install this product on a release, version, or type of operating
system other than one listed on the Product Version Availability screen described above,
consult Software AG technical support to determine whether support is possible, and under
what circumstances.

The Event Replicator Target Adapter Administration and the Event Replicator Target Adapter
Data Mapping Tool are not supported in HP-UX or zLinux environments because the Eclipse RCP
port is not available in those environments. You will need to have a Windows, AIX, Solaris or
Linux installation of the Administration Tool and Mapping Tool to use them. The Administration
Tool can remotely manage Event Replicator Target Adapter installations on those platforms where
the Eclipse RCP is not supported.

Supported Hardware

For general information regarding Software AG product compatibility with other platforms and
their requirements for Software AG products, visit Software AG'sHardware Supportedweb page.

Supported Browsers

For information on supported browsers, see the webMethods System Requirements documentation
on the Empower web site.

Supplied Third-Party Software

Event Replicator Target Adapter Administration uses Eclipse RCP Mars (version 4.5.2) and Eclipse
RCP DeltaPack (version 4.3.2). The Software AG Installer manages the installation of this third-
party software.

Note: If a third-party vendor drops support for a version of one of their products or even
for an entire product, Software AG automatically drops support for that version or product
as well.

Event Replicator Target Adapter Administration10
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Space Requirements

A minimum of 100 MB disk space (assuming all components are selected for installation) is required
to run all of the following products: Event Replicator Target Adapter Administration, Event Rep-
licator Target Adapter Data Mapping Tool, and the Event Replicator Target Adapter.

Note: Additional space is needed to store log files. The amount of space needed depends
entirely on the level of logging you select.

Memory Requirements

At least 2GB system memory is required to run this software.

1024 MB or more random access memory (RAM) may be needed, depending on the size of your
transactions.

Windows Requirements

In Windows environments, be sure to install Microsoft Visual Studio 2008 Redistributable Package.

Firewall Requirements

If you attempt to install and use this software in a system with a firewall in place, be sure that
your system administrator has set up the firewall so that the component applications can access
the ports they need. For more information about port usage, read the Port Number Reference found
elsewhere in this documentation.

Prerequisite Products

This section describes prerequisite products for Event Replicator Target Adapter Administration.

■ JRE Requirements
■ X-Windows Graphical Environment Requirement

Note: If a third-party vendor drops support for a version of one of their products or even
for an entire product, Software AG automatically drops support for that version or product
as well.

11Event Replicator Target Adapter Administration
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JRE Requirements

The Software AG Installer installs the appropriate Java Runtime Environment (JRE) along with
its infrastructure. This JRE does not interfere with any other JRE that might already exist on the
same host machine on which Event Replicator Target Adapter Administration is installed.

X-Windows Graphical Environment Requirement

UNIX and LINUX installations require an X-Windows graphical environment to run the Admin-
istration Tool.

Before You Begin

Before you begin installing this product, ensure that the following prerequisites have been met:

1. Software AG strongly recommends that you create an installation image of your existing Software
products and store the image on your internal network. You should create an image for each
operating system on which you plan to run the installation (for example, 32-bit, 64-bit, or both).
This will help you reduce WAN traffic and speed up installation and will ensure consistency
across installations over time, since the Software AG Installer provides only the latest release
of each product.

2. Close (stop) all open applications, especially those applications interacting with or depending
on your Adabas databases. This includes Natural, Adabas Manager, the Adabas DBA Workbench,
and prior releases of any other Adabas products. To be on the safe side, also shut down all
Software AG services.

Important: For some Software AG products, the Software AG Uninstaller will not be able
to remove key files that are locked by the operating system if the associated Software
AG products are not shut down.

3. Disable any antivirus software.

4. Ensure the target computer is connected to the network.

5. If this product requires a license key file, verify the license key file is copied somewhere in your
environment . Products requiring license key files will not run without valid license keys. For
more information, read The License Key, elsewhere in this section.

6. Verify your environment supports the system requirements for this product, as described in
System Requirements, elsewhere in this section.

Event Replicator Target Adapter Administration12
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Installation Steps

Event Replicator Target Adapter Administration is installed using the Software AG Installer. It
does not require a license key.

You can download the Software AG Installer from the Software AG Empower website at https://em-
power.softwareag.com/.

This installation documentation provides a brief description on how to install the Event Replicator
Target Adapter Administration directly on the target machine using the installer wizard. For de-
tailed information on the installer wizard, read Using the Software AG Installer.

Note: Read Using the Software AG Installer also if you want to use console mode, or if you
want to install using an installation script or installation image.

To install Event Replicator Target Adapter Administration, complete the following steps:

1 Start the Software AG Installer as described in Using the Software AG Installer.

2 When the first page of the Software AG Installer wizard (the Welcome panel) appears, choose
theNext button repeatedly, specifying all required information on the displayed panels, until
the panel containing the product selection tree appears.

All Adabas-related products (including Software AG Directory Server) can be selected for
installation within the Adabas Family product selection tree.

In addition to theAdabas Family product selection tree, two other trees, Event-DrivenArchi-
tecture and Infrastructure (which includes the System Management Hub installation) are
available for installation. The Infrastructure tree must be selected for all Software AG products;
it provides the necessary Java runtime environment for the Software AG Installer as well as
Event Replicator Target Adapter Administration.

3 To install Event Replicator Target Adapter Administration, select (check) the Event Replicator
Target Adapter Administration entry from the Adabas Family product selection tree.

4 On the License panel, read the license agreement and select the check box to agree to the terms
of the license agreement and then click Next to continue. If you do not accept the license
agreement, the installation will stop.

5 On the last panel, review the items you have selected for installation. If the list is correct,
choose the Next button to start the installation process.

After Event Replicator Target Adapter Administration has been installed, you will need to
manually start it. For more information, read Starting the Administration Tool under the section
entitledAbout the Event Replicator Target Adapter Administration Tool, elsewhere in this guide.
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Uninistallation Steps

You uninstall this product using the Software AG Uninstaller. For information on how to use the
uninstaller, read the Using the Software AG Installer guide.
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This chapter describes how to use the Event Replicator Target Adapter Administration. It covers
the following topics:

About the Event Replicator Target Adapter Administration Tool

This section describes how to start and stop the Event Replicator Target Adapter Administration
tool as well as the major features of the Event Replicator Target Adapter Administration tool in-
terface.

■ Supported Platforms
■ Starting the Administration Tool
■ Shutting Down the Administration Tool
■ The Main Window
■ Accessing the Preferences Area
■ Setting Configuration File and Target Adapter Preferences
■ Tree View
■ Menus
■ Toolbar
■ Getting Help

Note: The Event Replicator Target Adapter must be stopped and restarted every time an
Event Replicator Target Adapter definition is saved or deleted using the Administration
tool. For this reason, we recommend that you shut down the Event Replicator Target Adapter
prior to making changes to the definitions and restart the Event Replicator Target Adapter
when all definition changes are complete. For information about stopping and starting the
Event Replicator Target Adapter, read Shutting Down the Event Replicator Target Adapter and
Starting the Event Replicator Target Adapter, in the Event Replicator Target Adapter User Guide.

Supported Platforms

This release of the Event Replicator Target Adapter Administration tool is supported in Windows
environments and in Solaris, Linux and AIX environments that also support Eclipse.

Note: The Event Replicator Target Adapter Administration Tool and the Data Mapping
Tool are not supported in HP-UX or zLinux environments because the Eclipse RCP port is
not available in those environments. You will need to have a Windows, AIX,Solaris, or
Linux installation of the Administration Tool and Mapping Tool to use them. The Admin-
istration Tool can remotely manage Event Replicator Target Adapter installations on those
platforms where the Eclipse RCP is not supported.

Event Replicator Target Adapter Administration16
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Starting the Administration Tool

The Administration tool runs in both Windows and UNIX environments.

To start the Administration tool in Windows using the Windows Start menu, complete the following steps:

1 From the Windows Start menu, select All Programs.

2 Select <installation-directory>, where <installation-directory> is the name of the directory
in which you installed Event Replicator Target Adapter Administration. The default installation
directory is Software AG.

3 Select Administration.

4 Select Event Replicator Target Adapter for Mainframe v.r, where v.r represent the version
and release number of the Event Replicator Target Adapter.

5 Select Start Administration.

The Administration tool starts up.

Important: Before you can use the Administration tool, you must set preferences that
identify where the Event Replicator Target Adapter definitions should be stored, the
locations of the startup and shutdown commands for the Event Replicator Target Ad-
apter, and the location of the Event Replicator Target Adapter log files. For more in-
formation, read Setting Configuration File and Target Adapter Preferences, elsewhere
in this section.

To start the Administration tool in Windows using the administration.bat file, complete the following steps:

1 Navigate to the following directory: <installation-dir>/EventReplicatorTargetAdapterAd-
ministration/bin, where <installation-dir> is the name of the directory in which the Event
Replicator Target Adapter Administration program files were installed.

2 Run the administration.bat file.

The Administration tool starts up.

Important: Before you can use the Administration tool, you must set preferences that
identify where the Event Replicator Target Adapter definitions should be stored, the
locations of the startup and shutdown commands for the Event Replicator Target Ad-
apter, and the location of the Event Replicator Target Adapter log files. For more in-
formation, read Setting Configuration File and Target Adapter Preferences, elsewhere
in this section.
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To start the Administration tool in UNIX, complete the following steps:

1 Navigate to the following directory: <installation-dir>\bin, where <installation-dir> is the
name of the directory in which the Event Replicator Target Adapter Administration program
files were installed.

2 Source file sagenv.new to establish your environment variables by entering:

. ./sagenv.new

3 Run the administration.sh file.

The Administration tool starts up.

Important: Before you can use the Administration tool, you must set preferences that
identify where the Event Replicator Target Adapter definitions should be stored, the
locations of the startup and shutdown commands for the Event Replicator Target Ad-
apter, and the location of the Event Replicator Target Adapter log files. For more in-
formation, read Setting Configuration File and Target Adapter Preferences, elsewhere
in this section.

Shutting Down the Administration Tool

This section describes how to shut down the Administration tool in Windows environments. At
this time, the Administration tool only runs in Windows environments.

■ Shutting Down the Administration Tool Window
■ Shutting Down the Administration Tool from the Administration Tool

Shutting Down the Administration Tool Window

The simplest way of stopping the Administration tool is to shut down (kill) the window in which
it runs.

Shutting Down the Administration Tool from the Administration Tool

To shut down Event Replicator Target Adapter from the Administration tool:

■ Select the Exit command from the File menu.

The Administration Tool shuts down.
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The Main Window

When you first start up the Administration tool, the main window displays.

Accessing the Preferences Area

To access the preferences area of the Administration tool:

1 Start the Administration tool, as described in Starting the Administration Tool, elsewhere in
this guide.

The Administration tool main window appears.

2 Select the Preferences option from the Window menu.

The Preferences dialog appears. By default, the configuration file preferences are shown:
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3 Modify the Target Adapter environments with the commands described in the following
table, if necessary:

DescriptionCommand

Add an existing Target Adapter environment to the Administration
control.

Add

Edit the Target Adapter properties.Edit

Delete the Target Adapter environment from the Administration
control.

Note: This does not delete the Target Adapter installation.

Delete

Tip: The order of the Target Adapter environments in the Preferences Tree View is the same as in
this list. With the following commands you can control the order.

Move Target Adapter one position up in the Preferences Tree View.Up

Move Target Adapter one position down in the Preferences Tree
View.

Down
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Setting Configuration File and Target Adapter Preferences

The configuration file preferences identify, among other things, the location of the context.xml file
used to store the Event Replicator Target Adapter definitions you will set up using the Adminis-
tration tool. The Target Adapter preferences identify the locations of the Event Replicator Target
Adapter startup and shutdown commands as well as the location of its log files. If the configuration
file preferences are not supplied, you cannot set the Target Adapter preferences.

Caution: We do not recommend that you alter Event Replicator Target Adapter definitions
in the context.xml file using a text editor or any other editor other than the Event Replicator
Target Adapter Administration tool. If you do, errors may result.

To set configuration file and Target Adapter preferences:

1 Access the preferences area, as described in Accessing the Preferences Area, elsewhere in this
guide.

The Preferences dialog appears.

2 Select Target Adapter on the left side of the Preferences dialog.

3 Select the Target Adapter environment.

4 Click on the Edit… button.

The preferences appear on the Edit Target Adapter pop-up dialog.
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5 Modify the preferences as described in the following table, if necessary:

DescriptionPreference

Name of the Target Adapter environment that is displayed in the Tree View.Name
Remote Target Adapter

Check this option when the Target Adapter environment is on the remote
host, or if on the local machine but in a different installation suite location
than the tool.

Remote

Name of the remote host.Host

This command updates the Target Adapter Location according what is found
by the Adabas Administration Service.

Update

Adabas Administration Service
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DescriptionPreference

Specify the port number of the Adabas Administration Service. The default
is 3004.

Note: When using the Administration tool to administer a remote Event
Replicator Target Adapter installation, specify the Adabas Administration

Port

Service Port number and the host name (Hostfield) in the appropriate fields.
Once you either tab or click out of these fields or click Apply, the tool will
attempt to connect to the remote service and, if successful, will enter the
default locations for the context.xml (Configuration File field), startup script
(Startup File field), shutdown script (Shutdown File field), and the log file
directory (Log File Directory field) appropriate for the platform contacted.
If you have installed Event Replicator Target Adapter using a non-default
or non-standard installation location, you may need to manually adjust these
path values using the appropriate field(s) as described elsewhere in this table.
Once that is done, click Apply and the tool will verify the configuration.

Indicate whether or not the Event Replicator Target Adapter should be
automatically started and stopped by the Adabas Administration Service.

Automatically Start and
Stop Target Adapter via

Check this box if you want it to be automatically started; leave this box
unchecked if you do not.

Adabas Administration
Services
Target Adapter Location

Specify the fully-qualified path to the root directory of the Target Adapter
environment. The initial value in this field is determined using the path of

Root Directory

the Adabas Administration Service identified by the Host and Adabas
Administration Service Port fields and then applying the default installation
location of the log files to that path when the Update button is pressed.
Change this path as necessary for your installation.

The fully-qualified path of the location of the Event Replicator Target Adapter
log files. The initial value in this field is determined using the path of the

Log File Directory

Adabas Administration Service identified by the Host and Adabas
Administration Service Port fields and then applying the default installation
location of the log files to that path. Change this path as necessary for your
installation.

Specify the port number that should be used for communication between
the Tomcat server and the Administration tool via JMX. This port number

JMX Port

should match the port number you specified for JMX communication during
the Event Replicator Target Adapter installation. The default is 4000.

Indicate whether or not the Event Replicator Target Adapter configuration
file (context.xml) should be backed up whenever changes are made to the

Backup Configuration
File

Administration tool. Select the Backup radio button to request the backup;
select the No Backup radio button to suppress the backup.

This check box should be used only at the direction of your Software AG
technical support representative.

Show File Source

Indicate whether or not the warning dialog should be displayed when your
configuration is changed and the Event Replicator Target Adapter is running.

Show Warning Dialog
when Configuration
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DescriptionPreference

changed while Target
Adapter is up

When this check box is checked, the log file will be opened at the end of the
log file (showing the latest logged activity) when the Editor is opened or

Scroll to End of Log file
when Editor is opened
or refreshed refreshed. When this check box is not checked, the log file will automatically

open at the top of the file (showing the earliest logged activity in that log
file).

Set the version of the Target Adapter environment.Version

6 Click Validate Setting to validate the Target Adapter settings:

7 Click OK to apply the updates and close the Preferences dialog. No validation is performed;
you should validate settings before closing.

Click Cancel to close the Preferences dialog without update

Tree View

Each Target Adapter node now appears in the tree view, and each has an icon indicating the current
status:
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The icons are described in the following table:

The Target Adapter is running.

The Target Adapter is stopped.

The Target Adapter is coming up.

The Target Adapter is going down.

Checking the state of the Target Adapter.

The Target Adapter has an error. Perform Validate Setting in the Preferences to check for a cause.

Menus

The Administration tool main window has four menus. The commands on each menu are described
in the following table:

DescriptionMenu Item (Command)Menu

Allows you to create a new definition. When you select theNew command,
a submenu appears from which you can select the type of definition you
would like to create:

NewFile

■ Database Target: Select this option to create a new RDBMS database target
definition for the Event Replicator Target Adapter.

■ EntireX Communicator Source: Select this option to create a new
webMethods EntireX source definition for the Event Replicator Target
Adapter.
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DescriptionMenu Item (Command)Menu

■ Filter: Select this option to a create a new filter definition for the Event
Replicator Target Adapter

■ JMS Target: Select this option to a create a new JMS target definition for
the Event Replicator Target Adapter

■ Terracotta Target: Select this option to create a new Terracotta target
definition for the Event Replicator Target Adapter.

■ Terracotta Merge Target: Select this option to create a new Terracotta
Merge target definition for the Event Replicator Target Adapter.

■ Target Database Option: Select this option to create a option definition
for the target databases you have defined to Event Replicator Target
Adapter.

■ Web Service Target: Select this option to create a new web service target
definition for the Event Replicator Target Adapter.

■ WebSphere MQ Source: Select this option to create a new WebSphere
MQ source definition for the Event Replicator Target Adapter.

Allows you to close the definition you have currently selected in the
Administration tool. If the definition has not been saved, you will be
prompted to save it.

Close

Allows you to close all open definitions in the Administration tool. If any
definition has not been saved, you are prompted to save them.

Close All

Allows you to open an existing definition in the Administration tool.Open File

Saves the definition you have currently selected in the Administration tool.
If no name has been specified for a new definition, you are prompted for

one. You can also click the button on the toolbar to do this.

Save

Saves all the definitions you currently have open in the Administration tool.
If a name has not been specified for one or more definition, you are prompted

for them. You can also click the button on the toolbar to do this.

Save All

Refreshes the definitions in the Administration tool, based on the definitions
stored in the currently saved context.xml file. You can also press the F5 key
to refresh the definitions.

Refresh

Shuts down the Administration tool.Exit

Starts the Event Replicator Target Adapter. You can also click the button
on the toolbar to do this.

Start Target
Adapter

Run

Stops the Event Replicator Target Adapter. You can also click the button
on the toolbar to do this.

Stop Target
Adapter

Stops and restarts the Event Replicator Target Adapter. You can also click

the button on the toolbar to do this.

Restart Target
Adapter
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DescriptionMenu Item (Command)Menu

Allows you to set configuration file and target adapter preferences for the
Administration tool.

PreferencesWindow

Gives you access to the online help system shipped with the Administration
tool.

Help ContentsHelp

Allows you to search the online help system shipped with the Administration
tool.

Search

Displays information about the Administration tool you have installed.About Event
Replicator Target
Adapter
Administration

Toolbar

The Administration tool main window has four buttons on its toolbar. The buttons are described
in the following table:

DescriptionButton

Saves the definition you have currently selected in the Administration tool. If no name has been
specified for a new definition, you are prompted for one. You can also select the Save command on
the File menu to do this.

Saves all the definitions you currently have open in the Administration tool. If a name has not been
specified for one or more definition, you are prompted for them. You can also select the Save All
command on the File menu to do this.

Starts the Event Replicator Target Adapter. You can also select the Start Target Adapter command
on the Run menu to do this.

Stops the Event Replicator Target Adapter. You can also select the Stop Target Adapter command
on the Run menu to do this.

Stops and restarts the Event Replicator Target Adapter. You can also select the Restart Target
Adapter command on the Run menu to do this.

Getting Help

The Administration tool help through the Help menu. In addition, you can get information about
the version of the Administration tool you have installed by selecting the About Target Adapter
Administration option on the Help menu.

■ Using Tool Tip Help
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■ Getting Help from the Help Menu

Using Tool Tip Help

Tool tip help is available for some items within the Administration tool, including toolbar buttons
and menu items.

To use tool tip help, simply allow your mouse cursor to rest momentarily over an item for which
you would like help. For example, resting the mouse cursor over a toolbar button will display a
tool tip that describes a button.

Getting Help from the Help Menu

Click Help Contents option on the Help menu to access the online help for the Administration
tool. A browser opens to the documentation overview screen, allowing you to browse help by
topic or search for a specific help topic by clicking Search.

Activating Your Event Replicator Target Adapter License

As of v3.1 of Event Replicator Target Adapter, a license key is no longer required during installation.
Further, since licenses are now target specific, you may have been provided with more than one
license key file, depending on the terms of your license. With the Event Replicator Target Adapter
Administration you can manage your license keys.

Note: If you are using Event Replicator Target Adapter Administration to administer a remote
instance of Event Replicator Target Adapter, the license you are activating must be on a file
system accessible to your Event Replicator Target Adapter Administration installation. The
tool will send the license to the remote Event Replicator Target Adapter installation where
it will be saved locally on that machine.

■ Accessing the Licensing Configuration Screens
■ Adding New Licenses
■ Viewing License Key Details
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■ Deleting Licenses

Accessing the Licensing Configuration Screens

Right click on the appropriate Target Adapter node and select the item License Keys:

The following dialog is displayed:
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Adding New Licenses

To add new licenses

1 Click on the “Add…” button

2 Browse to the location where you have stored your license key(s)

3 Select the license file(s) you want to add and click “Open”

The following screen appears:

Note: It is possible to select more than one license key file at a time!
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Viewing License Key Details

To view the details of an activated license, select the license you want to view and press the “De-
tails…” button:

The following screen appears:

Deleting Licenses

To delete license keys:

■ Select the license(s) to be deleted and press the “Delete” button:

The following screen appears:
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and confirm your decision to delete your selected license key(s):

Maintaining the Event Replicator Target Adapter Engine Configuration

Note: Changes you make to the engine configuration require that the Event Replicator
Target Adapter be restarted. For information about restarting the Event Replicator Target
Adapter, read Restarting the Event Replicator Target Adapter, in the Event Replicator Target
Adapter User Guide.

To modify the Event Replicator Target Adapter engine configuration, complete the following steps:

1 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section
and then expand the Configurations section.

The Event Replicator Target Adapter engine and Repository configurations are listed under
Configurations.

3 Double-click on Engine .

The Engine Configuration panel appears on the right side of the window, as shown below:
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4 Verify and update the values on theEngineConfigurationpanel, as described in the following
table:

DescriptionField Name

Specify a description for the database option definition.Description

Specify the URL that identifies the location of the database processing used by the
Event Replicator Target Adapter. The format of this URL is:

Service URL

http://hostname:port/sqlrep/services/AdabasReptorPort

The hostname and the port number are the only things that should be changed
in this URL format. The hostname specified must be fully-qualified (for example
"myhost.mycompany.com").

Note: If you leave this field blank, the Event Replicator Target Adapter will
properly determine and construct the value for this parameter.
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DescriptionField Name

Select this option (check it) to indicate that an additional thread should be used
by the engine to improve throughput.

When you select this option, the additional thread is used; if you do not select this
option, it is not. In general, we recommend that you select this option.

XML Splitter
Thread

Select this option (check it) to indicate that unprocessed messages should be
committed. The default is to leave this option unchecked (unselected). Selecting

Commit
Unprocessed
Message this option will allow the Event Replicator Target Adapter to continue running if

an invalid message is received but includes the possibility of data inconsistency
issues between Adabas and the target RDBMS.

Specify how many engine threads should be run. Specifying one engine thread
for every replicated data source defined to the Event Replicator Target Adapter

Threads

can improve performance. However, defining more than one thread for every
data source is not necessary.

Specify the number of times that the Event Replicator Target Adapter engine
should attempt to communicate with the target if communication errors occur.
The default is "3" times.

Retry Count

Specify the number of seconds the Event Replicator Target Adapter engine should
wait between attempts to communicate with the target if communication errors
occur. The default is "30" seconds.

Retry Interval

Select this option (check it) to indicate that you want the XML documents received
from the Event Replicator Server written (in a readable form) to the directory
specified by the Directory field.

When you select this option, the XML documents are written; if you do not select
this option, they are not.

XML Capture

Specify the fully-qualified path of the directory in which XML documents received
from the Event Replicator Server should be written when theXMLCapture option

Directory

is turned on (checked). If available, use the Browse button to locate and select the
directory (when the Event Replicator Target Adapter is installed remotely, the
Browse button is not available).

5
Once all fields have been specified satisfactorily, click the Save button ( ) on the toolbar to
save the engine configuration.

Or:

Select the Save command on the File menu of the Administration tool.

The configuration is saved in the context file for the Event Replicator Target Adapter.
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Maintaining the Event Replicator Target Adapter Repository Configuration

The Event Replicator Target Adapter repository is used as a persistent store to save:

■ information sent to it by the Event Replicator Server
■ generated XSLT files.

Using the Event Replicator Target Adapter Administration tool, you can maintain the settings for
the persistent store.

Note: Changes you make to the repository configuration require that the Event Replicator
Target Adapter be restarted. For information about restarting the Event Replicator Target
Adapter, read Restarting the Event Replicator Target Adapter, in the Event Replicator Target
Adapter User Guide.

To modify the repository (persistent store) configuration, complete the following steps:

1 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section
and then expand the Configurations section.

The Event Replicator Target Adapter engine and repository configurations are listed under
Configurations.

3 Double-click on Repository .

TheWebDAVConfiguration panel appears on the right side of the window, as shown below:
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4 Verify and update the values on the WebDAV Configuration panel, as described in the fol-
lowing table:

DescriptionField Name

Specify a description for the repository configuration. This setting does not affect the
execution of the Event Replicator Target Adapter.

Description

Specify the URL that identifies the location of the repository used by the Event Replicator
Target Adapter. The format of this field is

URL

http://hostname:port/webdav/

The hostname and the port number are the only things that should be changed in this
URL format. The hostname specified must be fully-qualified (for example
"myhost.mycompany.com").

Note: We recommend that the WebDAV repository reside within the same Tomcat
instance as the Event Replicator Target Adapter.

Specify the repository collection name that should be used for the persistent store.Collection

Specify the number of files that should be internally cached to avoid reading files from
the repository. For optimal performance, this value will depend on how many files are

Cache Size
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DescriptionField Name

being replicated. You may want this value set to a slightly greater value than the actual
number of files being replicated, to allow for internal files that might be read. The default
is 20.

5
Once all fields have been specified satisfactorily, click the Save button ( ) on the toolbar to
save the WebDAV configuration.

Or:

Select the Save command on the File menu of the Administration tool.

Note: Changes to this configuration may require a restart of the Event Replicator Target
Adapter. For more information, read Restarting the Event Replicator Target Adapter, in
the Event Replicator Target Adapter User Guide.

The configuration is saved in the context file for the Event Replicator Target Adapter.

Configuring Target Definitions for Event Replicator Target Adapter

The Event Replicator Target Adapter supports three types of targets to which replicated data can
be submitted: JMS, RDBMS databases Terracotta caches and web services. Before you can use the
Event Replicator Target Adapter, you must set up a target definition for every unique target you
intend to use for the replicated data the Event Replicator Target Adapter processes. These definitions
provide Event Replicator Target Adapter with the information it needs to access your target and
to communicate with Event Replicator for Adabas via webMethods EntireX or WebSphere MQ.

■ Maintaining RDBMS Database Target Definitions
■ Maintaining JMS Target Definitions
■ Maintaining Terracotta and Terracotta Merge Target Definitions
■ Maintaining Web Service Target Definitions
■ Modifying Existing Target Definitions
■ Renaming Existing Target Definitions
■ Deleting Existing Target Definitions

Notes:

1. User authorization to maintain any new RDBMS tables via Event Replicator Target Adapter is
inherited from the site's privilege settings for the database. Authorization is managed by the
user's RDBMS privileges and not by Event Replicator Target Adapter. Event Replicator Target
Adapter will no longer grant RDBMS privileges to the user. Therefore, if you want to use Event
Replicator Target Adapter to maintain tables in an RDBMS, verify that your RDBMS authoriz-
ation privileges are correct for the maintenance you want to perform.

37Event Replicator Target Adapter Administration

Using Event Replicator Target Adapter Administration



2. You will need to restart the Event Replicator Target Adapter to fully process any additions or
changes made to Event Replicator Target Adapter configuration definitions in the Administration
tool. For more information, read Restarting the Event Replicator Target Adapter, in the Event Rep-
licator Target Adapter User Guide.

Maintaining RDBMS Database Target Definitions

You must define target definitions for each unique RDBMS database you intend to use with the
Event Replicator Target Adapter prior to using Event Replicator Target Adapter. These definitions
will provide Event Replicator Target Adapter with the information it needs to access your RDBMS
and to communicate with Event Replicator for Adabas via webMethods EntireX or WebSphere
MQ.

Note: Do not copy the context.xml, server.xml, or any configuration file from an older install-
ation and expect it to work for this installation. Errors will result if you try this.

To define a target definition for an RDBMS database:

1 Make sure you have completed all of the installation instructions specific to your RDBMS, as
described in one of the following sections, in the Event Replicator Target Adapter Installation
Guide:

■ Installation Considerations for DB2
■ Installation Considerations for DB2 on z/OS
■ Installation Considerations for Microsoft SQL Server
■ Installation Considerations for MySQL
■ Installation Considerations for Oracle
■ Installation Considerations for PostgreSQL
■ Installation Considerations for Teradata

2 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

3 On the left side of the Administration tool window, expand the Configuration File section
and then the Targets section.

The high-level categorizations of the target definitions appear.

4 Right-click on the Databases categorization and select New from the drop-down menu.

Or:
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Select the New command from the File menu and then Database Target from the resulting
submenu.

An untitled RDBMS database definition panel appears on the right side of the Administration
tool window, as shown below:

5 Supply valid values for the RDBMS database installed at your site. The database fields are
described here.

Data Source URL
Use this parameter to identify the fully qualified URL of the RDBMS database that should
be used by Event Replicator Target Adapter.

Note: The first database type shown in the RDBMS Target Type field affects the
template shown in the Data Source URL field.

The following table provides the URL format that should be used for the different relational
databases supported by Event Replicator Target Adapter:
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Data Source URL FormatRDBMS Type

DB2 jdbc:db2://hostname:port/instance

Replace hostnamewith the name of the host machine on which DB2 is installed, portwith
the DB2 listening port (the default is 50000), and instance with the case-sensitive name
of the DB2 database instance you created in the installation steps for DB2 (read Installation
Considerations for DB2 in the Event Replicator Target Adapter Installation Guide).

DB2 on
z/OS

jdbc:db2://hostname:port/instance

Replace hostname with the name of the host machine on which DB2 for z/OS is installed,
port with the DB2 for z/OS listening port, and instance with the case-sensitive name of
the DB2 database instance you created in the installation steps for DB2 for z/OS (read
Installation Considerations for DB2 on z/OS in the Event Replicator Target Adapter Installation
Guide).

Microsoft
SQL Server

jdbc:sqlserver://hostname:port;DatabaseName=dbname

Replace hostname with the name of the host machine on which Microsoft SQL Server is
installed, port with the SQL Server listening port (the default is 1433), and dbname with
the case-sensitive name of the Event Replicator Target Adapter database you created in
the installation steps for Microsoft SQL Server (read Installation Considerations for Microsoft
SQL Server in the Event Replicator Target Adapter Installation Guide).

Note: Note that named SQL Server instances are allowed and supported. Every instance
(named or default) must run on a different port. With Event Replicator Target Adapter 2.7
hotfix 3 and later releases, when you specify an instance name, it takes precedence over
any port number you might also supply; with earlier releases of the Event Replicator Target
Adapter, the port number takes precedence over the instance name. If neither an instance
name or port number is provided, the default port 1433 will be assumed. According to
Microsoft, however, optimal performance is obtained by specifying the port number without
the instance name. See Microsoft connection URL documentation
https://docs.microsoft.com/en-us/sql/connect/jdbc/building-the-connection-url for details.
So the safest and fastest way to specify the URL for named instances that will work even
using the bulk loader is using the hostname:port syntax.

MySQL jdbc:mysql://hostname:port/instance

Replace hostname with the name of the host machine on which MySQL is installed, port
with the MySQL listening port (the default is 3306), and instance with the case-sensitive
name of the MySQL database instance you created in the installation steps for MySQL
(read Installation Considerations for MySQL in the Event Replicator Target Adapter Installation
Guide).

Oracle jdbc:oracle:thin:@hostname:port:instance

Replace hostname with the name of the host machine on which Oracle is installed, port
with the port number for the database (the default is 1521), and instance with the Oracle
database instance name you created in the installation steps for Oracle (read Installation
Considerations for Oracle in the Event Replicator Target Adapter Installation Guide).
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Data Source URL FormatRDBMS Type

PostgreSQL jdbc:postgresql://hostname:port/database-name

jdbc:postgresql://hostname:port/databasename

Replace hostname with the name of the host machine on which PostgreSQL is installed,
port with the PostgreSQL listening port (the default is 5432), and database-name with
the case-sensitive name of the PostgreSQL database you created in the installation steps
for PostgreSQL (read Installation Considerations for PostgreSQL in the Event Replicator Target
Adapter Installation Guide).

Teradata jdbc:teradata://hostname/DATABASE=dbname,DBS_PORT=port[,CHARSET=utf8]

Replace hostname with the name of the host machine on which Teradata is installed,
dbname with the name of the Teradata database catalog you want to use, and port with
the Teradata listening port (read Installation Considerations for Teradata in the Event Replicator
Target Adapter Installation Guide).

Optionally, if you have applied an Event Replicator Target Adapter hot fix that provides
support for UTF-8 characters in Teradata databases, you can specify the "CHARSET=utf8"
parameter to indicate that you will be loading UTF-8 data to the database. For more
information about the hot fixes that support this, refer to the README file provided with
Event Replicator Target Adapter.

RDBMS Target Type
Identifies the type of the RDBMS. The following table provides the driver class value that
should be used for the different relational databases supported by Event Replicator Target
Adapter:

Driver Class ValueRDBMS Type

DB2 com.ibm.db2.jcc.DB2Driver

DB2 on z/OS com.ibm.db2.jcc.DB2Driver

Microsoft SQL Server com.microsoft.sqlserver.jdbc.SQLServerDriver

MySQL com.mysql.jdbc.Driver

Oracle oracle.jdbc.driver.OracleDriver

PostgreSQL org.postgresql.Driver ↩
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Driver Class ValueRDBMS Type

Teradata com.ncr.teradata.TeraDriver ↩

Note: Teradata RDBMS versions prior to version 12 will no longer be
supported in future versions of the Event Replicator Target Adapter.

Name
Specify a user name with authorization to access the database.

Password
Specify the password associated with the user name.

6 Supply the connection parameters:

Max. Active
Specify the maximum number of active connections provided by the connection pool.
Enter the number of maximum anticipated concurrent connections to the target. As a
guide, you should enter a number equivalent to the number of Event Replicator sources
that may at any one time be providing replicated data to this target.

Max. Idle
Specify the maximum number of idle connections in the connection pool. Usually this
number is set to the same as Max. Active.

Max. Wait
Specify the time (in milliseconds) that Event Replicator will wait for an available connection
from the connection pool.

Validation Query
The SQL query used to validate the connection. The default is determined by the target
type. We recommend not changing this value from the default.

7
Once all fields have been specified satisfactorily, click the Save button ( ) on the toolbar to
save the target database definition.

Or:

Select the Save command on the File menu of the Administration tool.

A Save As pop-up window appears.

Specify the name of the new target definition on the Save As pop-up window and then click
the OK button.

The definition is saved in the context file for the Event Replicator Target Adapter.
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Maintaining JMS Target Definitions

You can configure the Event Replicator Target Adapter to stream replicated data from the Event
Replicator to a JMS topic or queue managed by the webMethods Broker. To do this, you must
create a target definition for each unique JMS topic or queue with which you want Event Replic-
ator Target Adapter to interact.

To set up a JMS target definition for the Event Replicator Target Adapter, complete the following steps:

You must have a JMS target or queue created that is designed to handle the replicated data. For
information on setting this up in webMethods Broker, read EntireXMessage Service Provider (MSP),
available in the webMethods EntireX documentation on Software AG's Empower web site.

1 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section
and then the Targets section.

The high-level categorizations of the target definitions appear.

3 Right-click on the JMS categorization and select New from the drop-down menu.

Or:

Select theNew command from the Filemenu and then JMSTarget from the resulting submenu.

An untitled JMS target definition panel appears on the right side of the Administration tool
window, as shown below:
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4 Supply valid values for the JMS queue or topic. The JMS fields are described here.

Description
Type a description for this target definition.

Provider URL
Supply the fully-qualified URL of the initial context of the JNDI provider in which the
JMS-administered objects should be stored by the Event Replicator Target Adapter. This
JNDI provider must be managed by webMethods Broker. At this time, the Event Replic-
ator Target Adapter only supports JNDI providers managed by webMethods Broker.

Factory Initial
The class name of the JNDI factory. This class name is always "com.webmethods.jms.nam-
ing.WmJmsNamingCtxFactory".

Destination
Supply the lookup name of the destination. This is either the name of the JMS topic or the
JMS queue, as defined to webMethods Broker.

Connection Factory
Supply the name of the topic (publish-subscribe) or queue (point-to-point) connection
factory to be used, as defined to webMethods Broker.

Keep Empty Value
Select this option (check it) to indicate that all values of periodic (PE) fields or multiple-
value (MU) fields within PE fields should be replicated, even if they are empty. If this
option is NOT selected, only non-empty values of PE fields or MU fields within PE fields
are replicated.
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This option is only available for JMS targets running under OPTIONS=32 on the mainframe.

Update to Insert
Select this option (check it) to indicate that update commands should be converted to insert
commands. When this option is selected, the Event Replicator Target Adapter first issues
a delete of the existing row if it exists and then inserts a new row with the changed inform-
ation instead of issuing an update command. To use this feature, the mainframe replication
OPTIONS parameter specified in the destination class parameter data (DCLASSPARM
parameter) must be set to 32 (OPTIONS=32). For more information read DCLASSPARM
Parameter, in the Event Replicator for Adabas Reference Guide.

Caution: Specifying the OPTIONS=32 option results in the entire Adabas record
image being sent to the Event Replicator Target Adapter and can lead to the degrad-
ation of overall throughput and performance of the Event Replicator Target Adapter.

The default is to leave this option unchecked (unselected).

Note: This setting is ignored for requests to use a loader to process and load initial-
state data. For more information about the option to use a loader, read about the
Use Loader option.

Include Commit Information
Select this option (check it) to include Adabas commit time information in the replicated
data for all processed transactions. The default is to not include commit information in
the JMS message.

5
Once all fields have been specified satisfactorily, click the Save button ( ) on the toolbar to
save the target JMS definition.

Or:

Select the Save command on the File menu of the Administration tool.

A Save As pop-up window appears.

Specify the name of the new target definition on the Save As pop-up window and then click
the OK button.

The definition is saved in the context file for the Event Replicator Target Adapter.
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Maintaining Terracotta and Terracotta Merge Target Definitions

You can configure the Event Replicator Target Adapter to stream replicated data from the Event
Replicator to a Terracotta cache. To do this, you must create a target definition for Terracotta en-
vironment with which you want Event Replicator Target Adapter to interact. The Event Replicator
Target Adapter offers two different Terracotta targets: “Terracotta” and “Terracotta Merge”.
“Terracotta” replicates an Adabas file to a Terracotta cache. “Terracotta Merge” has the ability,
but is also able to merge multiple Adabas files to one cache via a single key.

To set up a Terracotta target definition for the Event Replicator Target Adapter, complete the following steps:

You must have a Terracotta environment that is designed to handle the replicated data. For inform-
ation on setting this up in Terracotta, read Terracotta documentation on Software AG's Empower
web site.

1 Start up the Administration tool, as described in Starting the Administration Tool.

2 On the left side of the Administration tool window, expand the Configuration File section
and then the Targets section.

The high-level categorizations of the target definitions appear.

3 Right-click on the Terracotta categorization and select New from the drop-down menu.

Or:

Select the New command from the File menu and then Terracotta Target from the resulting
submenu.

An untitled Terracotta target definition panel appears on the right side of the Administration
tool window, as shown below:

Terracotta target:
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Terracotta Merge target:

Supply valid values for the Terracotta target. The Terracotta fields are described in the follow-
ing table:

Type a description for this target definition.Description

Supply the path to ehcache.xml. Terracotta offer different types of cache: from local
cache to clustered server arrays. All parameters are controlled by the ehcache.xml file.
In order to connect to the right Terracotta instance, the Event Replicator Target Adapter
will use the specified configuration file. More details about the configuration file can be
found in the Terracotta documentation.

Config File
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Note: Only applicable for Terracotta Merge targets. By clicking on the “Add” button a
new merge cache definition can be defined.

Properties

Name of the merged cacheCache Name

Key that must exist in every merged fileKey

List of Adabas Files that are merge in the cache. The file must be separated with a comma.Files

4
Once all fields have been specified satisfactorily, click the Save button ( ) on the toolbar to
save the target Terracotta definition.

Or:

Select the Save command on the File menu of the Administration tool.

A “Save As” pop-up window appears.

Specify the name of the new target definition on the “Save As” pop-up window and then
click the OK button.

The definition is saved in the context file for the Event Replicator Target Adapter.

Note: The ehcache.xml file is not affected by any entries made here. You must provide
ehcache.xml according to your cache configuration. See the Terracotta documentation
on Software AG's Empower web site for more information on ehcache.xml.

Maintaining Web Service Target Definitions

You can configure the Event Replicator Target Adapter to stream replicated data from the Event
Replicator to a web service instead of an SQL database. To do this, you must create a target
definition for each unique web service with which you want Event Replicator Target Adapter to
interact.

To set up a web service target definition for the Event Replicator Target Adapter, complete the following
steps:

You must have a web service created that is designed to handle the replicated data.

1 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section
and then the Targets section.

The high-level categorizations of the target definitions appear.
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3 Right-click on the Web Service categorization and select New from the drop-down menu.

Or:

Select theNew command from the Filemenu and thenWebService Target from the resulting
submenu.

An untitled web service target definition panel appears on the right side of the Administration
tool window, as shown below:

4 Supply valid values for the web service. The web service fields are described here.

Description
Type a description for this target definition.

Web Service URL
Use this parameter to supply the fully-qualified URL of your web service.

5
Once all fields have been specified satisfactorily, click the Save button ( ) on the toolbar to
save the target web service definition.

Or:

Select the Save command on the File menu of the Administration tool.

A Save As pop-up window appears.
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Specify the name of the new target definition on the Save As pop-up window and then click
the OK button.

The definition is saved in the context file for the Event Replicator Target Adapter.

Modifying Existing Target Definitions

To modify an existing target definition:

1 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section
and then the Targets section.

The high-level categorizations of the target definitions (Database and Web Service) appear.

3 Expand the Database, JMS, or Web Service categorizations, locate the target definition you
want to modify in them, and double-click on the name.

The definition opens on the right side of the Administration tool.

4 Modify the values of the target definition as described in Defining New RDBMS Database
TargetDefinitions andDefiningNewWeb Service TargetDefinitions, elsewhere in this section.

5
Once all fields have been specified satisfactorily, click the Save button ( ) on the toolbar to
save the target definition.

Or:

Select the Save command on the File menu of the Administration tool.

The definition is saved in the context file for the Event Replicator Target Adapter.

Renaming Existing Target Definitions

To rename an existing target definition:

1 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section
and then the Targets section.

The high-level categorizations of the target definitions (Database and Web Service) appear.
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3 Expand the Database, JMS, or Web Service categorizations, locate the target definition you
want to rename, and right-click on the name.

A drop-down menu appears providing you with several options.

4 Select the Rename option on the drop-down menu.

A Rename dialog for the target definition appears. Here's a sample of such a dialog when
you rename a database target:

5 Supply a new name for the target definition in the space provided and click OK.

6 Make sure you have altered any source definitions that reference the target definition. For
more information, read Configuring Source Definitions for Event Replicator Target Adapter,
elsewhere in this guide.

In addition, make sure that any target database option definitions with the same name are
also renamed. Target database option definitions must have the same name as any target
database to which they apply (unless the default definition is used). For more information,
read Specifying Target Database Processing Option Definitions, elsewhere in this guide.

7
Once all fields have been specified satisfactorily, click the Save button ( ) on the toolbar to
save the target definition.

Or:

Select the Save command on the File menu of the Administration tool.

The definition is saved in the context file for the Event Replicator Target Adapter.

51Event Replicator Target Adapter Administration

Using Event Replicator Target Adapter Administration



Deleting Existing Target Definitions

To delete an existing target definition:

1 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section
and then the Targets section.

The high-level categorizations of the target definitions (Database and Web Service) appear.

3 Expand the Database, JMS, or Web Service categorizations, locate the target definition you
want to delete, and right-click on the name.

A drop-down menu appears providing you with several options.

4 Select the Delete option on the drop-down menu.

A dialog prompting you to verify that you really want to delete the target definition appears.

5 Select Yes to delete the definition.

6 Make sure you have altered any source definitions that reference the target definition. For
more information, read Configuring Source Definitions for Event Replicator Target Adapter,
elsewhere in this guide.

Specifying Target Database Processing Option Definitions

You can set processing options for your target databases. You do this by creating and using target
database processing option definitions.

■ Creating a New Target Database Option Definition
■ Modifying Existing Target Database Option Definitions
■ Renaming Existing Target Database Option Definitions
■ Deleting Existing Target Database Option Definitions

Note: You will need to restart the Event Replicator Target Adapter to fully process any ad-
ditions or changes made to Event Replicator Target Adapter Configuration definitions in
the Administration tool. For more information, read Restarting the Event Replicator Target
Adapter, in the Event Replicator Target Adapter User Guide.
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Creating a New Target Database Option Definition

You must define target definitions for each unique RDBMS database you intend to use with the
Event Replicator Target Adapter prior to using Event Replicator Target Adapter. These definitions
provide Event Replicator Target Adapter with the information it needs to access your RDBMS
and to communicate with Event Replicator for Adabas via webMethods EntireX or WebSphere
MQ.

Note: Do not copy the context.xml, server.xml, or any configuration file from an older install-
ation and expect it to work for this installation. Errors will result if you try this.

To create a new target database option definition:

1 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section.

3 Right-click on the Target Database Options section and select New from the drop-down
menu.

Or:

Select the New command from the File menu and then Target Database Option from the
resulting submenu.

An untitled target database option definition panel appears on the right side of the Adminis-
tration tool window, as shown below:
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4 Verify and update the values for the database option definition panel, as described in the
following table:

DescriptionField Name

Specify a description for the database option definition.Description

Specify zero (0) for this field unless specifically directed to change it by a support
representative.

This field specifies the recommended maximum number of SQL statements that
should be grouped and sent to the RDBMS to process as a batch. Use of this
environment entry can be used to improve the performance of your database and

Batch Count

is especially useful if you are requesting that initial-state data or ADALOD data be
replicated to your RDBMS database. The value you specify should be selected based
on your RDBMS database and network configuration requirements.

If you specify zero ("0") for this field, all SQL statements generated for a transaction
are grouped and processed in a single batch. If you specify any other value for this
field, then any generated SQL statements are grouped and processed in batches of
statements that do not exceed the number of statements you specified. For example
if you set this field to 1000, a maximum of 1000 SQL statements would be grouped
and processed in a single batch.

Note:
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DescriptionField Name

1. A single Adabas transaction can result in multiple SQL statements to update the
RDBMS database. To maintain database integrity, the Event Replicator Target
Adapter will be sure to group and process all of the SQL statements generated
for an individual transaction in one batch, regardless of the setting of the Batch
Count field.

2. The Event Replicator Target Adapter does not support use of this field for
Teradata databases; consequently, you should be sure that this field is set to zero
(0) for Teradata databases.

Select the level at which the Event Replicator Target Adapter should synchronize
the RDBMS table layout with the Adabas file.

The RDBMS-Adabas file synchronization (activated by this option) is triggered by
the use of a new GFB and field table (GFFT) in the subscription you use for

Adabas-RDBMS
Synchronization
Level

replication. Therefore, if you make changes to your Adabas database file or field
structure, you must generate a new GFB/GFFT (using the Data Mapping Tool) and
apply it to the appropriate subscription definition, prior to replicating data with
the new structure.

Valid values for this option are:

■ ignore: This is the default. The existing table layout is ignored, differences between
the RDBMS table layout and the Adabas file are ignored, and no synchronization
occurs.

This setting might cause Event Replicator Target Adapter processing to stop if
you have made changes to your Adabas database file or field structure and have
included a newly-generated GFB/GFFT in the subscription you use for replication.
When the Event Replicator Target Adapter receives the newly-structured
replicated data, but this option is set to "ignore", it will not attempt to synchronize
the RDBMS table layout with the new Adabas database structure. Any new or
enhanced fields will not be recognized by the Event Replicator Target Adapter
and processing will stop.

■ warn: Warning messages are written to the log about the differences between the
RDBMS table layout and the Adabas file, but no synchronization occurs.

This setting might cause Event Replicator Target Adapter processing to stop if
you have made changes to your Adabas database file or field structure and have
included a newly-generated GFB/GFFT in the subscription you use for replication.
When the Event Replicator Target Adapter receives the newly-structured
replicated data, but this option is set to "ignore", it will not attempt to synchronize
the RDBMS table layout with the new Adabas database structure (although it
will issue a warning message). Any new or enhanced fields will not be recognized
by the Event Replicator Target Adapter and processing will stop.

■ error: Event Replicator Target Adapter processing stops if the differences between
the RDBMS table layout and Adabas file cause errors. No synchronization occurs.
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DescriptionField Name

■ apply: The RDBMS is altered (synchronized) with the Adabas file, with the
following limitations:
■ No columns in the RDBMS table are removed, although they can be added.
■ The size or length of a data field will not be reduced. It can only be increased.
■ Data type conversions will not occur (for example, if Column A used to be an

integer but has been changed to VARCHAR).
■ Added or altered columns cannot contain foreign key, unique key, or a primary

key attribute.
■ RDBMS columns cannot be renamed.

Select this option (check it) to indicate that hyphens (-) in table and column names
should be automatically converted to underscore characters (_).

When you select this option, it indicates that hyphens in table and column names
should be converted to underscore characters; if you do not select this option, it
indicates that they should not.

Convert Hyphen

Select this option (check it) to indicate that the table and column names should be
automatically converted to lowercase.

When you select this option, it indicates that table and column names should be
converted to lowercase; if you do not select this option, it indicates that they should
not.

Lowercase

Select this option (check it ) to indicate that table and column names should be
included in quotation marks (").

When you select this option, it indicates that the table and column names should
be included in quotation marks; if you do not select this option, it indicates that

Use Quote

they should not. Be aware that not selecting this option has performance implications
because this setting causes the Event Replicator Target Adapter to analyze each
table and column name for use of special characters.

Select this option (check it) to indicate that Event Replicator Target Adapter should
continue processing when SQL transaction errors occur.

When you select this option, it indicates that, after logging the error, Event Replicator
Target Adapter should continue processing data when a SQL transaction error

Error Continue

occurs; if you do not select this option, it indicates that, after logging the error, Event
Replicator Target Adapter should terminate.

Select this option (check it) to indicate that an existing record should be deleted
before its replacement is inserted in the table. This allows you to specify how resent

Delete before
Insert

data from the Event Replicator is handled in the table. Data will be resent from the
Event Replicator if Event Replicator abnormally terminates and then is restarted.

Note: This setting is ignored for requests to use a loader to process and load
initial-state data. For more information about the option to use a loader, read about
the Use Loader option.
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DescriptionField Name

When you select this option, it indicates that existing records should be deleted
before their replacements are inserted; if you do not select this option, it indicates
that the replacement records should simply be inserted without deletion. Be aware
that selecting this option has performance implications because Event Replicator
Target Adapter must first determine whether each record it processes already exists
in the table.

Select this option (check it) to indicate that update commands should be converted
to insert commands. When this option is selected, the Event Replicator Target

Update to Insert

Adapter first issues a delete of the existing row if it exists and then inserts a new
row with the changed information instead of issuing an update command. To use
this feature, the mainframe replication OPTIONS parameter specified in the
destination class parameter data (DCLASSPARM parameter) must be set to 32
(OPTIONS=32). For more information read DCLASSPARM Parameter, in the Event
Replicator for Adabas Reference Guide.

Caution: Specifying the OPTIONS=32 option results in the entire Adabas record
image being sent to the Event Replicator Target Adapter and can lead to the
degradation of overall throughput and performance of the Event Replicator Target
Adapter.

The default is to leave this option unchecked (unselected).

Note: This setting is ignored for requests to use a loader to process and load
initial-state data. For more information about the option to use a loader, read about
the Use Loader option.

Binary Fields will be stores in Oracle fields with data type ‘raw’.Binary Fields as
RAWData Type

(Oracle only)

This option is only useful for Teradata databases.Reuse
Connection

Select this option (check it) to indicate that the data source connection should be
reused, instead of using the Tomcat connection pool. By selecting this option, you
can reduce the number of SQL commands issued by the JDBC driver, thus reducing
the performance overhead of Event Replicator Target Adapter processing to Teradata
databases.

The default is to leave this field unselected (unchecked).

This option is only useful for Microsoft SQL Server databases.User-Defined
Empty Value

Select this option (check it) to indicate that zero or null should be used to represent
an empty value for numeric, integer, or floating point fields directed to Microsoft
SQL Server databases. When you select this option, theNull for Type Decimal and
Null for Type Float fields become selectable.

The default is to leave this field unselected (unchecked).
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DescriptionField Name

This option was introduced in an Event Replicator Target Adapter hot fix, prior to
release 2.6. If you want to set this as the default for tables created before this option
was made available in the Event Replicator Target Adapter, you should run the
following command:

ALTER TABLE table_name ADD CONSTRAINT constraint_name DEFAULT 0 ↩
FOR column_name

Substitute the appropriate table, constraint, and column names in the command.

Likewise, if you want to change the values in the tables created before this option
was made available in the Event Replicator Target Adapter, run the following
command:

UPDATE table_name SET column_name = 0 WHERE column_name IS NULL

Substitute the appropriate table and column names in the command.

This option is only useful for Microsoft SQL Server databases. It only becomes
available if the User-Defined Empty Value option is selected (checked).

Null for Type
Decimal

Select this option (check it) to indicate that zero or null should be used for empty
numeric or integer fields directed to Microsoft SQL Server databases.

The default is to leave this field unselected (unchecked).

This option was introduced in an Event Replicator Target Adapter hot fix, prior to
release 2.6. If you want to set this as the default for tables created before this option
was made available in the Event Replicator Target Adapter, review the instructions
provided in the User-Defined Empty Value field above.

This option is only useful for Microsoft SQL Server databases. It only becomes
available if the User-Defined Empty Value option is selected (checked).

Null for Type
Float

Select this option (check it) to indicate that zero or null should be used for empty
floating point fields directed to Microsoft SQL Server databases.

The default is to leave this field unselected (unchecked).

This option was introduced in an Event Replicator Target Adapter hot fix, prior to
release 2.6. If you want to set this as the default for tables created before this option
was made available in the Event Replicator Target Adapter, review the instructions
provided in the User-Defined Empty Value field above.

Select this option (check it) to indicate that Oracle SQL*Loader, the Teradata
MultiLoad (MLoad) utility, the Microsoft SQL Server bulk copy (bcp) utility, the

Use Loader

DB2 CONNECT IMPORT or the PostgreSQL Loader (psql) utility command should
be used to process and load initial-state data into an Oracle, Teradata, Microsoft
SQL, DB2 or the PostgreSQL database. If you select this option, you should evaluate
the values for the Service, Path, Options, Environment File and Use Stream fields
on this screen, as these fields apply to the use of Oracle SQL*Loader in the Event
Replicator Target Adapter.

Event Replicator Target Adapter Administration58

Using Event Replicator Target Adapter Administration



DescriptionField Name

The default is to leave this field unselected (unchecked).

For more information on the use of the Oracle SQL*Loader to load initial-state data
in the Event Replicator Target Adapter, read Using the Oracle SQL*Loader to Load
Initial-State Data, in the Event Replicator Target Adapter User Guide. For more
information on the use of the Teradata MLoad utility to load initial-state data in the
Event Replicator Target Adapter, read Using the Teradata MultiLoad (MLoad) Utility
to Load Initial-State Data, in the Event Replicator Target Adapter User Guide. For more
information on the use of the Microsoft SQL Server bcp utility to load initial-state
data in the Event Replicator Target Adapter, read Using the Microsoft SQL Server
Bulk Copy (bcp) Utility to Load Initial-State Data, in the Event Replicator Target Adapter
User Guide. For more information on the use of the DB2 CONNECT IMPORT
command to load initial-state data in the Event Replicator Target Adapter, read
Using the DB2 CONNECT IMPORT Command to Load Initial-State Data, in the Event
Replicator Target Adapter User Guide.

For more information on the use of the PostgreSQL psql command to load initial-state
data in the Event Replicator Target Adapter, readUsing the PostgreSQL psql Command
to Load Initial-State Data, in the Event Replicator Target Adapter User Guide.

If Oracle SQL*Loader will be used to process and load initial-state data into an
Oracle database, optionally specify the Oracle database service name that should

Oracle Service,
Teradata Tdpip,

be used with the Oracle SQL*Loader. This is the service name you configured usingMicrosoft SQL
the Oracle Net Manager tool. Optionally, if the Oracle EZConnect feature isSchemaName or

DB2 Alias supported on this machine, you can specify the machine name, port number, and
database name instead of the service name. If the Oracle database is installed and
running on the same machine as the Event Replicator Target Adapter and only one
Oracle database is installed, this field should be left blank. This is the default. For
more information on the use of the Oracle SQL*Loader to load initial-state data in
the Event Replicator Target Adapter, read Using the Oracle SQL*Loader to Load
Initial-State Data, in the Event Replicator Target Adapter User Guide.

If the Teradata MLoad utility will be used to process and load initial-state data into
a Teradata database, specify the Teradata Director Program Identifier (TDPID) in
this field. This is usually the first eight characters of the Teradata database name or
the Teradata service name. Teradata database names can be up to 30 characters
long. However, MLoad restrictions for Teradata releases up to Version 12 require
that TDPIDs be eight (8) characters or less. Event Replicator Target Adapter current
logic dynamically determines the TDPID using the first eight characters of the name
specified in this field. If you do not supply a name, the first eight characters of the
Teradata database name is used. Whatever TDPID is used must also be present in
the HOSTS file. Be sure that the specifications in the database option definition and
the specification in the HOSTS file match. For more information on the use of the
Teradata MLoad utility to load initial-state data in the Event Replicator Target
Adapter, read Using the Teradata MultiLoad (MLoad) Utility to Load Initial-State Data,
in the Event Replicator Target Adapter User Guide.

If the Microsoft SQL Server Bulk Copy (bcp) utility will be used to process and load
initial-state data to a Microsoft SQL Server database, optionally specify the MS SQL
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DescriptionField Name

Server schema name in this field if the schema name is different from the user login
name. Prior to the release of MS SQL Server 2005, all tables created by MS SQL
Server used the user login name as the default schema name; in MS SQL Server
2005 and later versions, Microsoft suggests that you use "dbo" as the common schema
name (which is different from the user login name). If you have used any MS SQL
Server schema name that is not the same as the user login name, specify your
non-default schema name in the Oracle Service or Teradata Tdpip field. For more
information on the use of the Microsoft SQL Server bcp utility to load initial-state
data in the Event Replicator Target Adapter, read Using the Microsoft SQL Server
Bulk Copy (bcp) Utility to Load Initial-State Data, in the Event Replicator Target Adapter
User Guide.

If the DB2 CONNECT IMPORT command will be used to process and load
initial-state data into a DB2 database, specify the alias name of the DB2 database.
For more information on the use of the DB2 CONNECT IMPORT command to load
initial-state data in the Event Replicator Target Adapter, read Using the DB2
CONNECT IMPORTCommand to Load Initial-State Data, in the Event Replicator Target
Adapter User Guide.

If Oracle SQL*Loader, the Teradata MLoad utility, or the Microsoft SQL Server bulk
copy (bcp) utility will be used to process and load initial-state data into an Oracle,
Teradata, or Microsoft SQL Server database, this field is required.

Path to Loader
Executable

■ For Oracle SQL*Loader support, specify the full path of the Oracle SQL*Loader
executable. You can use the Browse... button to search for the executable on the
machine. For more information on the use of the Oracle SQL*Loader to load
initial-state data in the Event Replicator Target Adapter, read Using the Oracle
SQL*Loader to Load Initial-State Data, in the Event Replicator Target Adapter User
Guide.

■ For Teradata MLoad utility support, specify the full path of the Teradata MLoad
utility executable. You can use the Browse... button to search for the executable
on the machine. For more information on the use of the Teradata MLoad utility
to load initial-state data in the Event Replicator Target Adapter, read Using the
Teradata MultiLoad (MLoad) Utility to Load Initial-State Data, in the Event Replicator
Target Adapter User Guide.

■ For Microsoft SQL Server bulk copy (bcp) utility support, specify the full path of
the Microsoft SQL Server bcp utility executable. You can use the Browse... button
to search for the executable on the machine. For more information on the use of
the Microsoft SQL Server bcp utility to load initial-state data in the Event
Replicator Target Adapter, read Using the Microsoft SQL Server Bulk Copy (bcp)
Utility to Load Initial-State Data, in the Event Replicator Target Adapter User Guide.

■ For DB2 CONNECT IMPORT command support, specify the full path of the DB2
executable, db2cmd.exe. You can use the Browse... button to search for the
executable on the machine. For more information on the use of the DB2 CONNECT
IMPORT command to load initial-state data in the Event Replicator Target
Adapter, read Using the DB2 CONNECT IMPORT Command to Load Initial-State
Data, in the Event Replicator Target Adapter User Guide.
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DescriptionField Name

■ For PostgreSQL psql command support, specify the full path of the psql executable
(psql.exe on Windows, psql on Linux). You can use the Browse... button to search
for the executable on the machine. For more information on the use of the
PostgreSQL psql command to load initial-state data in the Event Replicator Target
Adapter, read Using the PostgreSQL psql Utility to Load Initial-State Data, in the
Event Replicator Target Adapter User Guide.

If the Microsoft SQL Server Bulk Copy (bcp) utility will be used to process and load
initial-state data into a Microsoft SQL Server database, you can specify the -b (batch

Options
(MSSQL, Oracle
or DB2 only) size) option in this field. This option specifies the number of rows per batch of

imported data. Each batch is imported and logged as a separate transaction that
imports the whole batch before being committed. By default, all rows in the data
file are imported as one batch. To distribute the rows among multiple batches, use
the -b option to specify a batch size that is smaller than the number of rows in the
data file. If the transaction for any batch fails, only insertions from the current batch
are rolled back. Batches already imported by committed transaction are unaffected
by a later failure. Do not use this option in conjunction with the -h
("ROWS_PER_BATCH=bb") option. The syntax of the -b option is:

-b batchsize

If Oracle SQL*Loader will be used to process and load initial-state data into an
Oracle database, the rows option can be specified in this field. The rows option
specifies the number of rows you want to read from the data file before a data save
is performed by the SQL*Loader. The syntax of the rows option is (where nnnn is
the number of rows):

rows=nnnn

Note: Use of the rows option can affect performance if it is set too low. We
recommend using it for testing and debugging purposes only or, if your file is very
large, it can be used to avoid resource restrictions that might arise. For complete
information on the rows option, refer to your Oracle SQL*Loader documentation.

For more information on the use of the Oracle SQL*Loader to load initial-state data
in the Event Replicator Target Adapter, read Using the Oracle SQL*Loader to Load
Initial-State Data, in the Event Replicator Target Adapter User Guide.

If the DB2 CONNECT IMPORT command will be used to process and load
initial-state data into a DB2 database, there are several options that can be specified
in this field. For a complete description of these options and the use of the DB2
CONNECT IMPORT command to load initial-state data in the Event Replicator
Target Adapter, readUsing theDB2CONNECT IMPORTCommand to Load Initial-State
Data, in the Event Replicator Target Adapter User Guide.

Note: This field is not required for Teradata MLoad utility or the PostgreSQL psql
utility support; Any values specified in this field for these targets are ignored.
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DescriptionField Name

Optionally, specify the file name containing the Oracle environment variables that
should be used with the Oracle SQL*Loader, if the SQL*Loader will be used to

EnvironmentFile

process and load initial-state data into an Oracle database. The Oracle environment
variables are used by UNIX and Linux operating systems. If used, the environment
variable file will contain settings for the PATH, ORACLE_BASE, and
ORACLE_HOME environment variables. You can use theBrowse... button to search
for the environment file on the machine.

If the environment variables are defined at the UNIX or Linux system level, this
field should be left blank. This is the default.

For more information on the use of the Oracle SQL*Loader to load initial-state data
in the Event Replicator Target Adapter, read Using the Oracle SQL*Loader to Load
Initial-State Data, in the Event Replicator Target Adapter User Guide.

Note: This field is not required for Teradata MLoad utility or Microsoft SQL Server
bcp utility or the PostgreSQL psql utility support; Any values specified in this field
for these targets are ignored

This optional field should only be selected if the Oracle SQL*Loader will be used
to process and load initial-state data into an Oracle database. Select this option

Use Stream
(Oracle only)

(check it) to indicate that records should be read in stream mode rather than first
being written to DAT files prior to being loaded into the Oracle database. Stream
mode processing is much faster and greatly reduces the disk space required for this
feature.

The default is to leave this field unselected (unchecked).

For more information on the use of the Oracle SQL*Loader to load initial-state data
in the Event Replicator Target Adapter, read Using the Oracle SQL*Loader to Load
Initial-State Data, in the Event Replicator Target Adapter User Guide.

Note: The use of this field for any target other than Oracle is ignored.

5
Once all fields have been specified satisfactorily, click the Save button ( ) on the toolbar to
save the target database option definition.

Or:

Select the Save command on the File menu of the Administration tool.

A Save As pop-up window appears.

Specify the name of the new target database option definition on the SaveAs pop-up window
and then click the OK button.

The definition is saved in the context file.
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Modifying Existing Target Database Option Definitions

To modify an existing target database option definition:

1 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section
and then expand the Target Database Options section.

The target database option definitions are listed.

3 Locate the definition in the list of option definitions and double-click on the name.

The definition opens on the right side of the Administration tool.

4 Modify the values of the target database option definition as described in Creating a New
Target Database Option Definition , elsewhere in this section.

5
Once all fields and options have been specified satisfactorily, click the Save button ( ) on
the toolbar to save the target database option definition.

Or:

Select the Save command on the File menu of the Administration tool.

The definition is saved in the context file for the Event Replicator Target Adapter.

Renaming Existing Target Database Option Definitions

To rename an existing target database option definition:

1 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section
and then expand the Target Database Options section.

The target database option definitions are listed.

3 Locate the definition in the list of option definitions and right-click on the name.

A drop-down menu appears providing you with several options.

4 Select the Rename option on the drop-down menu.
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A Rename dialog for the target database option definition appears.

5 Supply a new name for the definition in the space provided and click OK.

6 Make sure you have renamed any target definitions that share the same name as the target
database option definition. If you do not do this, the target database option definition will
not get applied to the correct target definition. For more information, readConfiguring Target
Definitions for Event Replicator Target Adapter, elsewhere in this guide.

7
Once all fields have been specified satisfactorily, click the Save button ( ) on the toolbar to
save the target database option definition.

Or:

Select the Save command on the File menu of the Administration tool.

The definition is saved in the context file for the Event Replicator Target Adapter.

Deleting Existing Target Database Option Definitions

To delete an existing target database option definition:

1 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section
and then expand the Target Database Options section.

The target database option definitions are listed.

3 Locate the definition in the list of option definitions and right-click on the name.

A drop-down menu appears providing you with several options.

4 Select the Delete option on the drop-down menu.

Event Replicator Target Adapter Administration64

Using Event Replicator Target Adapter Administration



A dialog prompting you to verify that you really want to delete the definition appears.

5 Select Yes to delete the definition.

Specifying Filter Definitions

You can set filter definitions for Event Replicator Target Adapter processing. You do this by creating
and using filter definitions. Transactions that meet the requirements set by filter definitions are not
processed by the Event Replicator Target Adapter (they are filtered out).

■ Creating a New Filter Definition
■ Filter Definition Processing
■ Modifying Filter Definitions
■ Renaming Filter Definitions
■ Deleting Filter Definitions

Note: You will need to restart the Event Replicator Target Adapter to fully process any ad-
ditions or changes made to Event Replicator Target Adapter configuration definitions in
the Administration tool. For more information, read Restarting the Event Replicator Target
Adapter, in the Event Replicator Target Adapter User Guide.

Creating a New Filter Definition

To create a new filter definition:

1 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section.

3 Right-click on the Filter section and select New from the drop-down menu.

Or:

Select the New command from the File menu and then Filter from the resulting submenu.

An untitled filter definition panel appears on the right side of the Administration tool window,
as shown below:
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4 Verify and update the values for the filter definition panel, as described in the following table:

DescriptionField Name

Optionally, specify a description for the filter definition.Description

Optionally, select this option (check it) to indicate that this filter definition should
be active. If this option is not selected, this filter definition will not be applied to the
transactions that Event Replicator Target Adapter processes.

The default is to select this option.

Active

Optionally, select this option (check it) to indicate that a message should be written
to the log when a transaction is filtered out from Event Replicator Target Adapter
processing because it meets all of the criteria specified by this filter condition.

The default is to unselect this option (uncheck it).

DisplayMessage

Optionally, specify the number of transactions that can be rejected by this filter
condition if all of the criteria specified by this filter are met. Valid values for this

Count

field are any positive integer or the word "all". For example, if "all" is specified, any
transaction that meets the conditions specified by this filter is rejected. If "6" is
specified, only the first six transactions that meet the conditions specified by this
filter are rejected.

The default is "all".

Optionally, specify an Adabas database ID for the filter definition. If a transaction
is processed by the Event Replicator Target Adapter for this database ID, the
transaction is rejected for Event Replicator Target Adapter processing.

Database ID

Optionally, specify an Adabas file number for the filter definition. If a transaction
is processed by the Event Replicator Target Adapter for this file number, the
transaction is rejected for Event Replicator Target Adapter processing.

File Number
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DescriptionField Name

Optionally, specify the name of an Event Replicator Target Adapter source definition
for the filter definition. If a transaction is processed by the Event Replicator Target

Source

Adapter from this source definition, the transaction is rejected for Event Replicator
Target Adapter processing.

Optionally, specify the name of an Event Replicator Target Adapter target definition
for the filter definition. If a transaction is processed by the Event Replicator Target

Target

Adapter for this target database, the transaction is rejected for Event Replicator
Target Adapter processing.

Optionally, specify the name of an Event Replicator subscription definition for the
filter definition. If a transaction is processed by the Event Replicator Target Adapter

Subscription

from this subscription, the transaction is rejected for Event Replicator Target Adapter
processing.

5
Once all fields have been specified satisfactorily, click the Save button ( ) on the toolbar to
save the filter option definition.

Or:

Select the Save command on the File menu of the Administration tool.

A Save As pop-up window appears.

Specify the name of the new filter definition on the Save As pop-up window and then click
the OK button.

The definition is saved in the context file for the Event Replicator Target Adapter.

Filter Definition Processing

An individual filter definition can specify many conditions (database ID, file number, source,
target, and subscription names). Any transaction that meets all of the conditions in an individual
filter definition is rejected by Event Replicator Target Adapter processing. In other words, the
conditions specified in an individual filter definition are logically ANDed by the Event Replicator
Target Adapter. If a transaction only meets a few of the conditions in an individual filter definition,
it is not rejected for processing.

You can also specify multiple filter definitions for Event Replicator Target Adapter processing. In
this case, if a transaction is rejected by any one of the filter definitions, it is not processed by the
Event Replicator Target Adapter. In other words, the conditions specified by different filter
definitions are logically ORed by the Event Replicator Target Adapter. If a transaction does not
meet all of the filter conditions in any individual filter condition (although it might meet a few
conditions in several different filter conditions) it is still processed by the Event Replicator Target
Adapter.
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Transactions that are filtered out can be identified in the Event Replicator Target Adapter log file,
depending on the setting of the Display Message option in the filter definition.

Modifying Filter Definitions

To modify an filter definition:

1 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section
and then expand the Filter section.

The filter definitions are listed.

3 Locate the definition in the list of option definitions and double-click on its name.

The definition opens on the right side of the Administration tool.

4 Modify the values of the filter definition as described in Creating a New Filter Definition ,
elsewhere in this section.

5
Once all fields and options have been specified satisfactorily, click the Save button ( ) on
the toolbar to save the filter definition.

Or:

Select the Save command on the File menu of the Administration tool.

The definition is saved in the context file for the Event Replicator Target Adapter.

Renaming Filter Definitions

To rename an existing filter definition:

1 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section
and then expand the Filter section.

The filter definitions are listed.

3 Locate the definition in the list of option definitions and right-click on its name.
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A drop-down menu appears providing you with several options.

4 Select the Rename option on the drop-down menu.

A Rename dialog for the target database option definition appears.

5 Supply a new name for the definition in the space provided and click OK.

6
Once all fields have been specified satisfactorily, click the Save button ( ) on the toolbar to
save the filter definition.

Or:

Select the Save command on the File menu of the Administration tool.

The definition is saved in the context file for the Event Replicator Target Adapter.

Deleting Filter Definitions

To delete an existing filter definition:

1 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section
and then expand the filter section.

The filter definitions are listed.

3 Locate the definition in the list of option definitions and right-click on its name.

A drop-down menu appears providing you with several options.

4 Select the Delete option on the drop-down menu.

A dialog prompting you to verify that you really want to delete the definition appears.
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5 Select Yes to delete the definition.

Configuring Source Definitions for Event Replicator Target Adapter

The Event Replicator Target Adapter supports two types of sources through which replicated data
can be submitted to your RDBMS databases and web services: webMethods EntireX and WebSphere
MQ (MQSeries). Before you can use the Event Replicator Target Adapter, you must set up a source
definition for every unique webMethods EntireX or WebSphere MQ data source you will be using
to retrieve the replicated data for your Event Replicator Target Adapter targets.

■ Defining a New webMethods EntireX Source Definition
■ Defining a New WebSphere MQ Source Definition
■ Specifying Global Source Trace Options
■ Modifying Existing Source Definitions
■ Renaming Existing Source Definitions
■ Deleting Existing Source Definitions

Note: You will need to restart the Event Replicator Target Adapter to fully process any ad-
ditions or changes made to Event Replicator Target Adapter configuration definitions in
the Administration tool. For more information, read Restarting the Event Replicator Target
Adapter, in the Event Replicator Target Adapter User Guide.

Defining a New webMethods EntireX Source Definition

You must define a webMethods EntireX source definitions for each unique webMethods EntireX
system that the Event Replicator Target Adapter needs to use to access your RDBMS and to com-
municate with Event Replicator for Adabas via webMethods EntireX.

To define a new webMethods EntireX source definition for Event Replicator Target Adapter:

1 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section.

3 Expand the Sources section.

4 Right-click on the EntireX Communicator section and then select New from the resulting
drop-down menu.

Or:

Select the New command from the File menu and then EntireX Communicator Source from
the resulting submenu.
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A blank webMethods EntireX source definition panel appears on the right side of the Admin-
istration tool window, as shown below:

5 Specify field values for the webMethods EntireX source definition on the panel. Each field
and option is described in the following table.

DescriptionEntry Name

Specify a description for this webMethods EntireX source definition.Description

Specify the location of the webMethods EntireX system that will be sending
replicated data to Event Replicator Target Adapter. The format of this location
must be in the format: hostname:port or tcpip-address:port.

If the host name is the same as the current machine, only the port number need be
specified.

Broker ID

Specify the unique name of the webMethods EntireX system that will be receiving
replicated data from the Event Replicator Server. This name should be specified
in the following format and is case-sensitive: Broker class/server/service

Service In

Specify the unique name of the webMethods EntireX system that will be used to
send initial-state requests from Event Replicator Target Adapter to the Event

Service Out

Replicator Server. This name should be specified in the following format and is
case-sensitive: Broker class/server/service
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DescriptionEntry Name

Click on the arrow associated with this field and select the target definition to
which replicated data received from this source should be sent.

Target

Specify the webMethods EntireX user ID required for security purposes. This field
is not optional.

Note: A user ID is required, regardless of whether or not any security is used by
webMethods EntireX.

User ID

Specify a unique ID for this source definition. This field is used to uniquely identify
this webMethods EntireX source when multiple sources are used. It is not optional.

A maximum of 32 alphanumeric characters can be specified.

Token

Note: A token is required, regardless of whether or not any security is used by
webMethods EntireX.

Specify the webMethods EntireX password associated with the user ID specified
in the User ID field.

This option is only required if EntireX is running with security.

Password

Select this option (check it) to indicate that this webMethods EntireX source
definition should be automatically started when the Event Replicator Target Adapter
is started.

The default is to leave this option unselected (unchecked).

Autostart

Select this option (check it) to indicate that system security is activated for this
source.

When you select this option, it indicates that system security is activated; if you
do not select this option, it indicates that system security is not activated.

Security

Select this option (check it) to indicate that messages should be written to the log
files indicating how many bytes were received from this source.

The default is to leave this option unselected (unchecked).

Display Receives

Select this option if your EntireX Broker queues are configured as Destination and
Input queues in the Event Replicator Server and are configured to use Single
Conversation Mode.

The default is to leave this option unselected (unchecked).

Single
Conversation
Mode

Specify the maximum number of records that should be prefetched for this source
before Event Replicator Target Adapter processing occurs for those records.

This field has no effect on queues configured for Single Conversation mode.

Prefetch Count

Indicate how long this source will wait for a message, in seconds. This is how long
the source will wait to receive a message before it attempts to receive a different
message. For webMethods EntireX sources, the default value is "1s" (one second).

Wait Time

Specify the maximum message size that can be processed by this source. The default
value is 32768 bytes.

Receive Length
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DescriptionEntry Name

Specify the number of times this source should attempt to connect to the target
RDBMS database or web service if the connection to the connection is down. The
default is "0" (zero) times.

This field and the Retry Interval field affect Event Replicator Target Adapter
RDBMS recovery processing. For more information, read RDBMS Recovery
Processing, in Event Replicator Target Adapter Concepts.

Retry Count

Specify the number of seconds this source should wait between attempts to
reconnect to the target RDBMS database or web service when the connection is
down. The default is "10s" seconds.

This field and theRetry Count field affect Event Replicator Target Adapter RDBMS
recovery processing. For more information, read RDBMS Recovery Processing, in
Event Replicator Target Adapter Concepts.

Retry Interval

Specify the webMethods EntireX data compression level for data coming to the
Event Replicator from this source. Valid compression levels are integers ranging

Compression

from "0" (zero, or no compression) to "8" (maximum compression). The default is
"0".

Select this option (check it) to indicate that all incoming Event Replicator messages
should be captured to a sequential file for debugging purposes. This file is stored

Capture Mode

with the other log files created for Event Replicator Target Adapter. For more
information, read Managing Event Replicator Target Adapter Log Files and Console
Messages, in the Event Replicator Target Adapter User Guide.

Note:

1. Selecting this option may impact performance.

2. If the Event Replicator Target Adapter is started with capture turned on, any
existing log file is deleted and a new one is created.

Specify the fully-qualified name of the capture log file to which Event Replicator
messages will be written if the Capture Mode option is selected. You can click on
the Browse... button associated with this field to select the file.

Path to File

6
Once all fields have been specified satisfactorily, click the Save button ( ) on the toolbar to
save the webMethods EntireX source definition.

Or:

Select the Save command on the File menu of the Administration tool.

A Save As pop-up window appears.

Specify the name of the new webMethods EntireX source definition on the Save As pop-up
window and then click the OK button.

73Event Replicator Target Adapter Administration

Using Event Replicator Target Adapter Administration



The definition is saved in the context file for the Event Replicator Target Adapter.

Defining a New WebSphere MQ Source Definition

You must define an WebSphere MQ source definitions for each unique WebSphere MQ system
that the Event Replicator Target Adapter needs to use to access your RDBMS and to communicate
with Event Replicator for Adabas via WebSphere MQ.

To define a new WebSphere MQ source definition for Event Replicator Target Adapter:

1 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section.

3 Expand the Sources section.

4 Right-click on theWebSphereMQ section and then selectNew from the resulting drop-down
menu.

Or:

Select the New command from the File menu and then WebSphere MQ Source from the
resulting submenu.

A blank WebSphere MQ source definition panel appears on the right side of the Administration
tool window, as shown below:
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5 Specify field values for the WebSphere MQ source definition on the panel. Each field and
option is described in the following table.

DescriptionEntry Name

Specify a description for this WebSphere MQ source definition.Description

Specify the case-sensitive WebSphere MQ host name.Host

Specify the WebSphere MQ port number.Port

Specify the case-sensitive WebSphere MQ queue manager name to which you are
trying to connect.

Queue Manager

Specify the case-sensitive WebSphere MQ channel name to which you are trying
to connect.

Channel

Specify the case-sensitive WebSphere MQ queue name you want to use to receive
replicated data from the Event Replicator Server.

Queue In

Specify the case-sensitive WebSphere MQ queue name you want to use to send
initial-state requests from Event Replicator Target Adapter to the Event Replicator
Server.

Queue Out

Click on the arrow associated with this field and select the target definition to which
replicated data received from this source should be sent.

Target

Specify the WebSphere MQ user ID required for security purposes.User ID
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DescriptionEntry Name

Specify the WebSphere MQ password associated with the user ID specified in the
User ID field.

Password

Select this option (check it) to indicate that this WebSphere MQ source definition
should be automatically started when the Event Replicator Target Adapter is started.

The default is to leave this option unselected (unchecked).

Autostart

Select this option (check it) to indicate that system security is activated for this
source.

When you select this option, it indicates that system security is activated; if you do
not select this option, it indicates that system security is not activated.

Security

Indicate how long this source will wait for a message, in seconds. This is how long
the source will wait to receive a message before it attempts to receive a different

Wait Time

message. If you are using WebSphere MQ, set the wait time to a value greater than
"0"; its default is "1s" (one second).

Specify the number of times this source should attempt to connect to the target
RDBMS database or web service if the connection to the connection is down. The
default is "0" (zero) times.

This field and theRetry Intervalfield affect Event Replicator Target Adapter RDBMS
recovery processing. For more information, read RDBMS Recovery Processing, in
Event Replicator Target Adapter Concepts.

Retry Count

Specify the number of seconds this source should wait between attempts to reconnect
to the target RDBMS database or web service when the connection is down. The
default is "10s" seconds.

This field and theRetry Count field affect Event Replicator Target Adapter RDBMS
recovery processing. For more information, read RDBMS Recovery Processing, in
Event Replicator Target Adapter Concepts.

Retry Interval

Select this option (check it) to indicate that all incoming Event Replicator messages
should be captured to a sequential file for debugging purposes. This file is stored

Capture Mode

with the other log files created for Event Replicator Target Adapter. For more
information, read Managing Event Replicator Target Adapter Log Files and Console
Messages, in the Event Replicator Target Adapter User Guide.

Note:

1. Selecting this option may impact performance.

2. If the Event Replicator Target Adapter is started with capture turned on, any
existing log file is deleted and a new one is created.

Specify the fully-qualified name of the capture log file to which Event Replicator
messages will be written if the Capture Mode option is selected. You can click on
the Browse... button associated with this field to select the file.

Path to File
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6
Once all fields have been specified satisfactorily, click the Save button ( ) on the toolbar to
save the WebSphere MQ source definition.

Or:

Select the Save command on the File menu of the Administration tool.

A Save As pop-up window appears.

Specify the name of the new WebSphere MQ source definition on theSaveAspop-up window
and then click the OK button.

The definition is saved in the context file for the Event Replicator Target Adapter.

Specifying Global Source Trace Options

You can specify global trace options for your webMethods EntireX and WebSphere MQ sources.

Note: You cannot specify global source trace options for a source type that has not been
defined. For example, you cannot specify WebSphere MQ trace options if no WebSphere
MQ sources have been defined.

■ Specifying Global webMethods EntireX Trace Options
■ Specifying Global WebSphere MQ Trace Options

Specifying Global webMethods EntireX Trace Options

To specify global webMethods EntireX trace options:

1 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section.

3 Expand the Sources section.

4 Right-click on the EntireX Communicator section and then select Open from the resulting
drop-down menu.

Or:

Double-click on EntireX Communicator.

The Global EntireX Communicator Source panel appears on the right side of the Adminis-
tration tool window, as shown below:
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5 Verify and update the values for the trace option definition panel, as described in the following
table:

DescriptionField Name

Specify a description for the trace options.Description

Specify the name of the trace file to be used.Trace File

Specify the level of tracing that should be performed.

Valid values range from "0" (no trace) to "5".

If you request that source tracing occur, the trace file is created and is stored with the
other log files created for Event Replicator Target Adapter. For more information, read

Trace Level

Managing Event Replicator Target Adapter Log Files and Console Messages, in the Event
Replicator Target Adapter User Guide.

Note:

1. Turning tracing on (by setting this field to a value greater than 0) may impact
performance.

2. If the Event Replicator Target Adapter is started with trace turned on, any existing
trace file is deleted and a new one is created.

6
Once all fields have been specified satisfactorily, click the Save button ( ) on the toolbar to
save the trace settings.

Or:

Select the Save command on the File menu of the Administration tool.

The trace settings are saved in the context file for the Event Replicator Target Adapter.
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Specifying Global WebSphere MQ Trace Options

To specify global WebSphere MQ trace options:

1 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section.

3 Expand the Sources section.

4 Right-click on the WebSphere MQ section and then select Open from the resulting drop-
down menu.

Or:

Double-click on WebSphere MQ.

The Global WebSphere MQ Source panel appears on the right side of the Administration
tool window, as shown below:

5 Verify and update the values for the trace option definition panel, as described in the following
table:

DescriptionField Name

Specify a description for the trace options.Description

Specify the name of the trace file to be used.Trace File

Specify the level of tracing that should be performed.

Valid values range from "0" (no trace) to "5".

If you request that source tracing occur, the trace file is created and is stored with the
other log files created for Event Replicator Target Adapter. For more information, read

Trace Level
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DescriptionField Name

Managing Event Replicator Target Adapter Log Files and Console Messages, in the Event
Replicator Target Adapter User Guide.

Note:

1. Turning tracing on (by setting this field to a value greater than 0) may impact
performance.

2. If the Event Replicator Target Adapter is started with trace turned on, any existing
trace file is deleted and a new one is created.

6
Once all fields have been specified satisfactorily, click the Save button ( ) on the toolbar to
save the trace settings.

Or:

Select the Save command on the File menu of the Administration tool.

The trace settings are saved in the context file for the Event Replicator Target Adapter.

Modifying Existing Source Definitions

To modify an existing source definition:

1 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section
and then the Sources section.

The high-level categorizations of the source definitions (EntireX Communicator and Web-
Sphere MQ) appear.

3 Locate the source definition in theEntireXCommunicator orWebSphereMQ categorization,
as appropriate and double-click on the name.

The definition opens on the right side of the Administration tool.

4 Modify the values of the source definition as described inDefining aNewwebMethods EntireX
Source Definition and Defining a NewWebSphere MQ Source Definition, elsewhere in this
section.

5
Once all fields have been specified satisfactorily, click the Save button ( ) on the toolbar to
save the source definition.
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Or:

Select the Save command on the File menu of the Administration tool.

The definition is saved in the context file for the Event Replicator Target Adapter.

Renaming Existing Source Definitions

To rename an existing source definition:

1 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section
and then the Sources section.

The high-level categorizations of the source definitions (EntireX Communicator and Web-
Sphere MQ) appear.

3 Locate the source definition in the EntireX Communicator orWebSphereMQ categorization
and right-click on the name.

A drop-down menu appears providing you with several options.

4 Select the Rename option on the drop-down menu.

A Rename dialog for the source definition appears. Here's sample dialog for renaming a
webMethods EntireX source definition:

5 Supply a new name for the source definition in the space provided and click OK.

6
Once all fields have been specified satisfactorily, click the Save button ( ) on the toolbar to
save the source definition.

Or:
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Select the Save command on the File menu of the Administration tool.

The definition is saved in the context file for the Event Replicator Target Adapter.

Deleting Existing Source Definitions

To delete an existing source definition:

1 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section
and then the Sources section.

The high-level categorizations of the source definitions (EntireX Communicator and Web-
Sphere MQ) appear.

3 Locate the source definition in the EntireX Communicator orWebSphereMQ categorization
and right-click on the name.

A drop-down menu appears providing you with several options.

4 Select the Delete option on the drop-down menu.

A dialog prompting you to verify that you really want to delete the source definition appears.

5 Select Yes to delete the definition.

Verifying Your Source Definition Connections

Event Replicator Target Adapter provides two commands (batch utilities) you can use to verify
the connection between your environment and the source definition.

Caution: Do not run these commands if Event Replicator Target Adapter is already started.
If it is started, stop it before running these commands. In addition, both of these commands
will drain the input queue if anything is in it.

These commands are located in the bin directory, wherever the Event Replicator Target Adapter
source code and program files are installed.

■ Use the etbivp command to verify the connection between your environment and webMethods
EntireX.

■ Use the mqsivp command to verify the connection between your environment and WebSphere
MQ.
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At a command prompt, navigate to the bin directory and enter the appropriate command, using
one of the following syntaxes:

etbivp brokerID class/server/service tracelevel (scm userid token password)

or

mqsivp queuemgr host port channel queue tracelevel

where:

■ brokerID is the URL (host:port) of the webMethods EntireX Broker system to which you are
trying to connect.

■ class/server/service is the case-sensitive class, server, and service name of the webMethods
EntireX Broker to which you are trying to connect.

■ queuemgr is the case-sensitive WebSphere MQ queue manager name to which you are trying to
connect.

■ host is the WebSphere MQ host name.
■ port is the WebSphere MQ port number.
■ channel is the case-sensitive WebSphere MQ channel to which you are trying to connect.
■ queue is the case-sensitive WebSphere MQ queue name to which you are trying to connect.
■ tracelevel is the trace level that should be used for the connection attempt. Valid values range

from "0" (no trace) through "5". The default is "0".

Optional for etbivp if the EntireX Broker queue is configured for Single Conversation Mode:

■ scm indicates you are connecting to an input queue configured for Single Conversation Mode.
■ userid is the Broker userid.
■ token is the user token (Single Conversation Mode).
■ password is an optional password if the EntireX Broker is running in secured mode.

If errors occur when you run etbivp or mqsivp, rerun them using a trace level setting of "3". Then
submit the trace log to your webMethods EntireX or WebSphere MQ administrators to identify
the problem. For more information about Event Replicator Target Adapter log files, readManaging
Event Replicator Target Adapter Log Files and Console Messages, in the Event Replicator Target Adapter
User Guide.
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Reviewing and Dynamically Altering Definitions

You can review all of the configuration definitions you have specified in the Administration tool.
In addition, you can dynamically alter some of them while the Event Replicator Target Adapter
is running; there is no need to restart the Event Replicator Target Adapter to pick up these changes.

Note: Some configuration definitions can only be altered in the configuration area of the
Administration tool. Changes to these settings require that you restart the Event Replicator
Target Adapter to fully process the changes. For more information, readRestarting the Event
Replicator Target Adapter, in the Event Replicator Target Adapter User Guide.

To review configuration definitions in the Administration tool and optionally modify the editable fields:

1 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 Verify that the Event Replicator Target Adapter is started. If is not, start it now. For more in-
formation, read Starting the Event Replicator Target Adapter, in the Event Replicator Target Adapter
User Guide

3 On the left side of the Administration tool window, expand the Target Adapter section and
then expand the Configurations section.

The configuration definitions are listed under Configurations.

4 Click on any definition under Configurations

The specifications for configuration definition you selected appear on the right side of the
window, where you can review them.

Any fields on the right side of the window that appear in bright blue can be dynamically
altered. For example, in the following window the DbErrorContinue and
DbDeleteBeforeInsert properties can be dynamically altered.
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5 Optionally, modify any fields you want that appear in bright blue on the right side of the

window. When all your updates are made, click the Save button ( ) on the toolbar to save
the configuration definition.

Or:

Select the Save command on the File menu of the Administration tool.

The configuration definition is saved in the context file for the Event Replicator Target Adapter.

Reviewing Log Files

You can review all of the Event Replicator Target Adapter log files located in the \logs subdirectory
wherever your Event Replicator Target Adapter program data files are installed.

To review log files in the Administration tool:

1 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.
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2 Verify that the Event Replicator Target Adapter is started. If is not, start it now. For more in-
formation, read Starting the Event Replicator Target Adapter, in the Event Replicator Target Adapter
User Guide.

3 On the left side of the Administration tool window, expand the Target Adapter section and
then expand the Logs section.

The log files are listed under Logs.

4 Click on any log file under Logs

The contents of the log file appear on the right side of the screen. The following example
shows one selected log file's contents on the right side of the screen:

Note: You can use the Refresh button to refresh the display.
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Reviewing Event Replicator Target Adapter Statistics

As records are received and processed by the Event Replicator Target Adapter, statistics are
passively updated. When the Event Replicator Target Adapter shuts down, the final statistics for
the session are written to a log file with a name in the format ArtMetrics_yyyymmdd_hhmmss.log,
where yyyymmdd_hhmmss is the date and time that the log file is written. You can review all of the
Event Replicator Target Adapter log files located in the \logs subdirectory wherever your Event
Replicator Target Adapter program data files are installed.

You can also review the ongoing Event Replicator Target Adapter processing statistics from the
Administration tool.

To review the ongoing Event Replicator Target Adapter processing statistics in the Administration tool:

1 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 Verify that the Event Replicator Target Adapter is started. If is not, start it now. For more in-
formation, read Starting the Event Replicator Target Adapter, in the Event Replicator Target Adapter
User Guide.

3 On the left side of the Administration tool window, expand the Target Adapter section and
then expand the Status section.

The statistics areas are listed under Status.

4 Click on any statistic area under Status

The processing statistics for that area appear on the right side of the screen. The following
example shows the status of the configuration engine on the right side of the screen:

Note: You can use the Refresh button to refresh the display.
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The following table provides lists each of the statistics collected, with a brief explanation of each.

Note: This list may not be complete or comprehensive. Changes to the statistics collected
may change at any time.

DescriptionStatisticCategory Type

Event Replicator Target Adapter average processing time.

This value is the average of the backend Event Replicator
Target Adapter internal processing time. It is expressed

artLastAverageEngine
(/engine/...)

in milliseconds. There are two parts of such backend
processing time:

■ The first part is RDBMS-related elapsed time, including
JDBC SQL statement execution time and database
metadata retrieval time.

■ The second part is the Event Replicator Target Adapter
internal processing time.

The value of artLastAverage is calculated as the total time
spent in backend Event Replicator Target Adapter internal
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DescriptionStatisticCategory Type

processing during the last minute divided by the number
of backend calls occurring in that minute.

The number of database retry attempts.DbRetries

Total number of messages processed.EngNumMsgs

The number of messages processed in under 100
milliseconds

EngNumMsgsLt100Ms

The number of messages processed in under 10
milliseconds.

EngNumMsgsLt10Ms

The number of messages processed in under 50
milliseconds.

EngNumMsgsLt50Ms

The number of messages processed in under 999
milliseconds.

EngNumMsgsLt999Ms

The number of messages processed in over 001 second.EngNumMsgsMt001Sec

The number of call requests processed.ProcessRequestCalls

The number of transaction requests processed.ProcessRequestTrans

The number of asynchronous process calls split.SplitterCallRequest

The number of splitter calls completed with no waits.SplitterNoWaits

The number of splitter calls that waited for a resource.SplitterWaits

Event Replicator Target Adapter display statistics time.sPrintArtTime

The number of receives issued.SrcReceiveCount

The engine state.State

The number of capture files written.XmlCaptureFiles

The file ID.FileIdFile Source
(/source/sourcename) The last exception time.FileLastException

The number of bytes received.FileNumBytesReceived

The number of commits.FileNumCommits

The number of exceptions.FileNumExceptions

The number of messages.FileNumMsgs

The number of rollbacks.FileNumRollbacks

The processing time.FileProcessingTime

The last exception time.FileTimeException

The shutdown time.FileTimeShutdown

The start time.FileTimeStart

The current state.State

Last transaction information.TransactionInfo

Event Replicator Target Adapter processes executed in
under 10 milliseconds.

artExecLt10MsRDBMS Target
(/jdbc/targetname)
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DescriptionStatisticCategory Type

Event Replicator Target Adapter processes executed in
under 50 milliseconds.

artExecLt50Ms

Event Replicator Target Adapter processes executed in
under 100 milliseconds.

artExecLt100Ms

Event Replicator Target Adapter processes executed in
under 999 milliseconds.

artExecLt999Ms

Event Replicator Target Adapter processes executed in
over 1 second.

artExecMt001Sec

Event Replicator Target Adapter average processing time.

This value is the average of the backend Event Replicator
Target Adapter internal processing time. It is expressed

artLastAverage

in milliseconds. There are two parts of such backend
processing time:

■ The first part is RDBMS-related elapsed time, including
JDBC SQL statement execution time and database
metadata retrieval time.

■ The second part is the Event Replicator Target Adapter
internal processing time.

The value of artLastAverage is calculated as the total time
spent in backend Event Replicator Target Adapter internal
processing during the last minute divided by the number
of backend calls occurring in that minute.

The database name.DbName

The database version.DbVersion

The database URL.DbUrl

The database driver class.DbDriverClass

The database driver name.DbDriverName

The database driver version.DbDriverVersion

JDBC processes executed in under 10 milliseconds.dbExecLt10Ms

JDBC processes executed in under 50 milliseconds.dbExecLt50Ms

JDBC processes executed in under 100 milliseconds.dbExecLt100Ms

JDBC processes executed in under 999 milliseconds.dbExecLt999Ms

JDBC processes executed in over 1 second.dbExecMt001Sec

The database user name.DbUserName

The number of commits to this database.Commits

The number of connections to this database.Connections

The number of connections reused.ConnectionsReused
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DescriptionStatisticCategory Type

JDBC average processing time.

Event Replicator Target Adapter records the time it takes
to execute SQL statements via JDBC. It then calculates the

lastAverage

JDBC average processing time by dividing the total JDBC
elapsed time (in milliseconds) for all requests during the
last minute by the total number of JDBC requests in
milliseconds in the last minute.

This value is only updated when there are JDBC function
calls. It is usually zero unless SQL statements are being
heavily processsed.

Note: A single JDBC function call may contain more than
one SQL statement.

The number of fake DB insert/update/delete attempts.sFakeIUD

Event Replicator Target Adapter display backend statistics
time.

sPrintArtTime

The number of statements for this database.Statements

The time of last connection.TimeLastConnection

Total RDBMS time.TransactionTime

The number of transaction requests.ProcessRequestCallsSubscription

Last transaction information.TransactionInfo

The number of exceptions.BrkExceptionNumwebMethods EntireX
Source
(/source/sourcename)

The last exception time.BrkExceptionTime

The last exception type.BrkExceptionType

The webMethods EntireX Broker ID.BrkId

webMethods EntireX Broker information.BrkInfo

The number of bytes received.BrkNumBytesReceived

The number of bytes sent.BrkNumBytesSent

The number of commits performed.BrkNumCommits

The number of messages processed.BrkNumMsgs

The number of messages received in under 100
milliseconds.

BrkNumMsgsLt100Ms

The number of messages received in under 10
milliseconds.

BrkNumMsgsLt10Ms

The number of messages received in under 50
milliseconds.

BrkNumMsgsLt50Ms

The number of messages received in under 999
milliseconds.

BrkNumMsgsLt999Ms

The number of messages received in over 001 second.BrkNumMsgsMt001Sec

91Event Replicator Target Adapter Administration

Using Event Replicator Target Adapter Administration



DescriptionStatisticCategory Type

The maximum number of prefetched messages.BrkNumPrefetchMax

The number of messages received.BrkNumRcvs

The number of rollbacks.BrkNumRollbacks

The number of sends.BrkNumSends

The number of UOWs.BrkNumUows

The last commit time.BrkTimeCommit

The last receive time.BrkTimeReceive

The last rollback time.BrkTimeRollback

The last send time.BrkTimeSend

The shutdown time.BrkTimeShutdown

The start time.BrkTimeStart

The current state.State

Last transaction information.TransactionInfo

The WebSphere MQ host machine.MqsCfgHostWebSphere MQ Source
(/source/sourcename) The WebSphere MQ port number.MqsCfgPort

The last exception.MqsLastException

The number of bytes received.MqsNumBytesReceived

The number of bytes sent.MqsNumBytesSent

The number of commits.MqsNumCommits

The number of exceptions.MqsNumExceptions

The number of messages.MqsNumMsgs

The number of receives.MqsNumRcvs

The number of rollbacks.MqsNumRollbacks

The number of sends.MqsNumSends

The last commit time.MqsTimeCommit

The last exception time.MqsTimeException

The last receive time.MqsTimeReceive

The last rollback time.MqsTimeRollback

The last send time.MqsTimeSend

The shutdown time.MqsTimeShutdown

The start time.MqsTimeStart

The current state.State

Last transaction information.TransactionInfo

The URL of the JMS provider.JMSProviderJMS Target
(/source//<targetname>) The JMS factory class in use.JMSFactory

The configured connection factory.JMSConnection
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DescriptionStatisticCategory Type

The destination topic.JMSDestination

The number of create statements processed.JMSNumCreates

The number of insert statements processed.JMSNumInserts

The number of update statements processed.JMSNumUpdates

The number of delete statements processedJMSNumDeletes

The number of drop statements processed.JMSNumDrops

The location of the ehcache.xml file.ParameterTerracotta Target
(/target/<targetname>) The number of create statements processed.GenericNumCreates

The number of insert statements processed.GenericNumInserts

The number of update statements processed.GenericNumUpdates

The number of delete statements processed.GenericNumDeletes

The number of drop statements processed.GenericNumDrops

The number of populate statements processed.GenericNumPopulates
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5 Supported Relational Databases

The following relational databases (RDBMS) are supported by Event Replicator Target Adapter
Administration:

Required JDBC DriverRDBMS Support

db2jcc4.jarDB2 9.1 for open systems,or later

db2jcc4.jar
db2jcc_license_cisuz.jar

DB2 Universal Database (UDB) version 9 for z/OS,
or later

sqljdbc4.jarMicrosoft SQL Server 2005 and later

mysql-connector-java-v.r.s-bin.jar , where v.r.s
represents the MySQL release number.

MySQL 5.0.17, or later

ojdbc6.jarOracle 10g or later

postgresql-v.r-1002.jdbc4.jar, where v and r represent the
first two parts of the PostgreSQL version number.v.r.s

PostgreSQL 9.2 or later

tdgssconfig.jar
terajdbc4.jar

Teradata Version 2 Release 1.2 for open systems,
or later
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